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Thank you for purchasing this RKC product. In order to achieve maximum performance and ensure proper 
operation of your new instrument, carefully read all the instructions in this manual. Please place the manual 
in a convenient location for easy reference. 

NOTICE -Paperless Recorder- 
 This manual assumes that the reader has a fundamental knowledge of the principles of electricity, process 

control, computer technology and communications. 

 The figures, diagrams and numeric values used in this manual are only for purpose of illustration.  

 RKC is not responsible for any damage or injury that is caused as a result of using this instrument, 
instrument failure or indirect damage. 

 RKC is not responsible for any damage and/or injury resulting from the use of instruments made by 
imitating this instrument. 

 Periodic maintenance is required for safe and proper operation of this instrument. Some components have 
a limited service life, or characteristics that change over time. 

 Every effort has been made to ensure accuracy of all information contained herein. RKC makes no 
warranty expressed or implied, with respect to the accuracy of the information. The information in this 
manual is subject to change without prior notice. 

 No portion of this document may be reprinted, modified, copied, transmitted, digitized, stored, processed 
or retrieved through any mechanical, electronic, optical or other means without prior written approval 
from RKC. 

 

 

 

 An external protection device must be installed if failure of this instrument could 
result in damage to the instrument, equipment or injury to personnel. 

 All wiring must be completed before power is turned on to prevent electric shock, 
fire or damage to instrument and equipment. 

 Don't use this product in any method not specification by manufacturer. The 
protective features of this product may be impaired if it is used in a method not 
specified in the operation manual. 

 This instrument must be used in accordance with the specifications to prevent fire 
or damage to instrument and equipment. 

 This instrument is not intended for use in locations subject to flammable or 
explosive gases. 

 Do not touch high-voltage connections such as power supply terminals, etc. to 
avoid electric shock. 

 Do not use in an environment where there is strong electromagnetic interference. 
May cause the operation to become unstable. 

 RKC is not responsible if this instrument is repaired, modified or disassembled by 
other than factory-approved personnel. Malfunction can occur and warranty is void 
under these conditions. 

 

WARNING 
 
 
 
 

All Rights Reserved, Copyright  2018～2021, RKC INSTRUMENT INC. 
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 This product is intended for use with industrial machines, test and measuring equipment.  

(It is not designed for use with medical equipment and nuclear energy.) 
 This is a Class A instrument. In a domestic environment, this instrument may cause radio 

interference, in which case the user may be required to take additional measures. 
 This instrument is protected from electric shock by reinforced insulation. Provide reinforced 

insulation between the wire for the input signal and the wires for instrument power supply, source of 
power and loads. 

 Be sure to provide an appropriate surge control circuit respectively for the following: 
- If input/output or signal lines within the building are longer than 30 meters. 
- If input/output or signal lines leave the building, regardless the length. 

 This instrument is designed for installation in an enclosed instrumentation panel. All high-voltage 
connections such as power supply terminals must be enclosed in the instrumentation panel to avoid 
electric shock by operating personnel. 

 All precautions described in this manual should be taken to avoid damage to the instrument or 
equipment. 

 All wiring must be in accordance with local codes and regulations. 
 All wiring must be completed before power is turned on to prevent electric shock, instrument failure, 

or incorrect action. 
The power must be turned off before repairing work for input break and output failure including 
replacement of sensor, contactor or SSR, and all wiring must be completed before power is turned 
on again. 

 To prevent instrument damage or failure, protect the power line and the input/output lines from high 
currents with a protection device such as fuse, circuit breaker, etc. 

 Prevent metal fragments or lead wire scraps from falling inside instrument case to avoid electric 
shock, fire or malfunction. 

 Tighten each terminal screw to the specified torque found in the manual to avoid electric shock, fire 
or malfunction. 

 For proper operation of this instrument, provide adequate ventilation for heat dispensation. 
 Do not connect wires to unused terminals as this will interfere with proper operation of the 

instrument. 
 Turn off the power supply before cleaning the instrument. 
 Do not use a volatile solvent such as paint thinner to clean the instrument. Deformation or 

discoloration will occur. Use a soft, dry cloth to remove stains from the instrument. 
 To avoid damage to instrument display, do not rub with an abrasive material or push front panel with 

a hard object. 
 This instrument is intended to be used under the following environmental conditions. 

Installation features: Indoor  
Altitude: 2000 m or less 
Ambient temperature: 0-50 °C 
Ambient humidity: 20-80 %RH (Non-condensing) 
Overvoltage category: Category II 
Allowable pollution degree: Pollution degree 2 

 Power module that is used in the instruments conform to EN60950-1/A12: 2011. 

CAUTION 
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 When installing this instrument, put on a protective gear such as safety shoes, helmet, etc. for your 
safety. 

 Do not put your foot on the installed instrument or get on it, because it is dangerous. 
 Only our serviceman or persons authorized by RKC are allowed to remove and take the inner 

module, the main unit and printed circuit boards apart. 
 In case of damage or failure, contacting serviceman of our company, instruments should be against 

unintended operation. 
 
 

FOR PROPER DISPOSAL 
When disposing of each part used for this instrument, always follows the procedure for disposing of 
industrial wastes stipulated by the respective local community. 

 

 

 

SYMBOLS USED ON THE INSTRUMENT 
The symbols below are used on this instrument for the cautioning information. 

 
This shows “Caution for handling”.  
This symbol is used on the parts need to reference the instruction manual for saving 
human body and the instrument.  
 
This shows “Protective grounding”.  
Be sure to provide protective grounding prior to operate this instrument. 
 

This shows “Risk of electric shock”.  
This symbol is used on the parts, which has a risk of electric shock. 
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NOTICE -Ex.Sec Viewer- 
 This manual assumes that the reader has a fundamental knowledge of the principles of electricity, process 

control, computer technology and communications. 

 The figures, diagrams and numeric values used in this manual are only for purpose of illustration.  

 RKC holds the ownership and copyright of this software and this document. 

 RKC is not responsible for any damage or injury that is caused as a result of using this product, 
instrument failure or indirect damage. 

 RKC is not responsible for any damage and/or injury resulting from the use of the product made by 
imitating this product. 

 The specifications of the software and the information in this document are subject to change without 
prior notice. 

 If the specifications of the software do not correspond with the contents of this document, the software 
specifications have priority. 

 RKC software is licensed for use with one computer and cannot be modified. This software may not be 
duplicated except for backup purposes. 

 Every effort has been made to ensure accuracy of all information contained herein. RKC makes no 
warranty expressed or implied, with respect to the accuracy of the information. 

 No portion of this document may be reprinted, modified, copied, transmitted, digitized, stored, processed 
or retrieved through any mechanical, electronic, optical or other means without prior written approval 
from RKC. 

 

 

 

 

 Modbus is a registered trademark of Schneider Electric.  
 Windows is registered trademarks of Microsoft Corporation. 
 Company names and product names used in this manual are the trademarks or registered 

trademarks of the respective companies. 
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1.INTRODUCTION 
 

This manual describes the extended security function. 
For details about other functions of this device, refer to the manual of the recorder. 

1.1 Outline 
This extended security function achieves high-level security with the following functions added to the 
VGR-B100 paperless recorder. 
In combination with dedicated support software, this function can be used in a variety of applications 
that require stringent security and electronic signature such as the medicine manufacturing process. 
 
The extended security function has roughly the following five functions. For details, refer to Chapter 2. 
- Access restriction function 

This function enables user authentication using the password. You can select from two user levels. 
You can also restrict available functions or periodically prompt the user to change the password by 
configuring settings. 

- Audit trail function 
This function saves up to 1,000 records when the user performs each operation or change settings. Up 
to 50 setting information files (parameter files) can be also saved when settings are changed. 

- Electronic signature function 
This function supports the electronic signatures of up to three users using dedicated viewer software. 

- Signature data output function 
This function can be used to print and output signed electronic data. 

- Falsification detection function 
The function to detect falsification in measurement data prohibits viewing if falsification is found in 
measurement data or measurement data is corrupted. 

 

 

 

 

 

 

 

 

 

 

[Notes] 
- The following operations cannot be performed when the extended security function is enabled. 

1. Modification of each parameter, start/stop of recording, reset of accumulated data, recording of 
messages, and manual calibration of SNTP using the Modbus communication function. 

2. Modification of parameters via network using the parameter loader. 
3. Start/stop of recording using the data viewer. 
4. Start/stop of recording using the DI function. 
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1.2 Other operation manual 
The following manuals are also provided for this device: 
Name Description 
VGR-B100  
PAPERLESS RECORDER 
OPERATION MANUAL 

Manual that describes other functions than the extended security 
function. 

VGR-B100 
PAPERLESS RECORDER 
COMMUNICATION FUNCTION 
OPERATION MANUAL 

Manual that describes the Modbus communication function. 

DATA VIEWER 
INSTRUCTION MANUAL 
FOR VGR-B100 
PAPERLESS RECORDER 

Manual that describes how to check data recorded with this device 
or support software that enables real-time observation of currently 
recorded data. 

PARAMETER LOADER 
INSTRUCTION MANUAL 
FOR VGR-B100 
PAPERLESS RECORDER 

Manual that describes support software that can be used to check 
parameters currently set to this device or create and specify 
parameters. 

 

1.3 Accessory check 
The accessories shown here are used in relation to the extended security function option. For details about 
other accessories, refer to the manual of the recorder. In case that there are inappropriate parts, contact 
your dealer or our sales staff. The following accessories are attached to the extended security function 
option. Check that these accessories are included. 
 

 

 

 

 

 

 

 (1) Authentication-key (2) CD-ROM 
(Manual and support software) 
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- SD card on the market is sold having formatted it usually, therefore, it is not necessary to 

format it again. Please go with this Recorder when formatting it. When formatting it by 
the format feature of the personal computer standard, it is likely not to operate correctly. 

- Please confirm it is a correct direction and the firm insertion when it installs it. The 
Recorder cannot recognize the SD card when forcibly inserting it in a wrong direction. 
Moreover, it causes the breakdown of the SD card and the main body of the Recorder. 
Please note that the damage of the equipment when it reversely inserts it becomes off the 
subject of the guarantee. 

- Please do not turn off power in recording of the SD card, and do not detach the SD card. 
Data might damage, and delete it. 

- When the SD card breaks, important recorded data is lost. The data preserved on the card 
recommends the backup to be booked once a month. 

- MiniSD and the microSD card cannot be used. The use of miniSD and the microSD card 
adaptor has the possibility that the card doesn't come off, therefore, please do not use it. 

 

1.4 Handling SD card 
Correspondence SD card is as follows. 
- Panasonic corporation  1～32GB 
- SanDisk corporation  1～32GB 
There is no SD card in this equipment. Please buy it in the computer shop etc. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

●About removing SD card 
Removable operation with the SD remove key can’t be executed during extended security mode. 
During recording, please confirm that SD card writing is not in progress and remove the SD card. 
When recording is stopped, you can remove the SD card at any time. 
※ Please do not remove the SD card absolutely during the screen display below. The recorded data may 

be damaged. 
 

Caution 
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● Standard of record 
The standard of the record when the SD card of 2GB is used is as follows. Please note that the 
capacity that can be recorded by the situation of the occurrence of warning and the message is 
different. 

[Condition] 
- Number of inputs ： 6 point 

 - Recorded data form ：Binary 
 - Record type ：Maximum/minimum value record 
 - There is no event of the alarm, message etc. 

 
※ The record exceeding the product-life cycle is not guaranteed. 
Capacity of SD card 2GB 
File preservation cycle 1 hour 1 day 
Data logging cycle 1 sec 2 sec 5 sec 1 sec 10 sec 1 min 
Capacity that can be recorded 1.0 year 1.4 year 1.8 year 1.9 year 14.0 year 33.7 year 
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2.EXTENDED SECURITY FUNCTION 
 

2.1 Overview 
The extended security function has the following functions: 
* For the "21 CFR Part 11" correspondence list of the extended security function, refer to Appendix 4 " 

Extended security function list for 21 CFR Part 11". 

No. Function Description 
Function in 

the 
recorder 

Ex.Sec 
Viewer Reference 

1 Access restriction 
function  

You can select from two 
levels, that is, the 
administrator account and the 
user (general) account. In 
addition, you can restrict 
operations, setting, and 
signature of user accounts. 

✓ － 

To enable the extended security 
function: 
→ Section 4.2.1, "Enabling the 

extended security function" 
 
To register a user account with 
operation restriction: 
→ Section 4.2.4, "Registering a user 

with operation restriction" 
 
About the account registration screen 
→ Section 4.3.1, "Registering a 

user" 
 
About the security mode setting screen 
→ Section 4.3.2, "Security mode" 
 

2 Audit trail function This function automatically 
stores records on operations 
such as modification of setting 
values or start/stop of 
recording. This function also 
saves parameters immediately 
after setting and records them 
in the parameter log file when 
you set parameters. 

✓ ✓ 
(check only) 

To check audit trails on the screen of 
this device: 
→ Section 4.2.8, "Checking audit 

trails (security logs)" 
 
To check audit trails with support 
software: 
→ Section 5.2.4, " Check and print 

the audit trail (security log)" 
 
About the security log screen 
→ Section 4.3.4, "Security logs 

(audit trails)" 
 
About the parameter log file 
→ Section 4.5.4, "Parameter log 

file" 
 
About the list of security logs 
→ Appendix 2 "List of Security 

Logs" 
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No. Function Description 
Function in 

the 
recorder 

Ex.Sec 
Viewer 

Reference 

3 Electronic signature 
function 

This function can be used to 
check and sign data. － ✓ 

To sign data: 
→ Section 5.2.3, "Checking and 

signing record data" 
4 Signature data output 

function 
This function can be used to 
print trends, instantaneous 
values, and audit trail data 
which signature data is added 
to. This function can also 
output raw (binary) data. 

－ ✓ 

To print signed record data: 
→ Section 5.2.5, "Printing signed 
record data" 
   Section 5.2.6, "  " 
To migrate record data to another PC: 
→ Section 5.2.9, "Migrating signed 
record data to another PC" 

5 Data 
falsification/corruption 
detection function 

This function detects 
falsification and corruption in 
record data and restricts 
viewing of data. 

－ ✓ 

About data corruption indication 
→Section 5.3.7 ” Display and 
operation in each state of the recorded 
data” 

 

2.2 Access restriction function 
Access restriction function in this device 

- This function only allows the accounts that have the operation right to access this device. 
- The login operation is always required to perform operations and setting. 
- Two account levels (administrator and user) are available. 

Administrator: Can use all the functions in this device. 
User: Can use permitted functions only. 

- The total of up to 20 administrator and user accounts can be registered. 
- The user name, password, and arbitrary text can be registered as account information. 
- The password has an expiration period. You must set a new password at login after the expiration 

period. The initial expiration period is 365 days. 

 
 
- Can perform all the operations and 
settings. 
- Can arbitrarily set access restrictions to 

user accounts. 
- Can make a signature. 

 
 
- Can only perform the operations and 

settings permitted by the administrator 
account. 

- Can make a signature only when permitted 
by the administrator account. 

Administrator account User account 
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Access restriction function image 

With operation restriction 

Measurement data is recorded on the 
recorder 

Recorder 

Confirm and sign the measurement 
data with Ex.Sec Viewer 

Ex.Sec Viewer（PC） 

No operation restriction 

SD crad 

data 

Administrator 
 

 

User account 
 

Administrator account 
 

User account 
 

Login 
 

Login 
 

Login 
 

Login 

With operation restriction 

No operation restriction 
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2.3 Audit trail 
Audit trail function in this device 

- This function automatically logs user operations such as modification of setting values or start/stop 
of recording as timestamped audit trails. Audit trails are called security logs in this device. Logs 
are displayed in security logs. 

- The recorder records up to 1,000 log records. When the number of log records exceeds 1,000, the 
oldest log record is overwritten and updated. 

- When you change a setting value, the parameter file immediately after change is saved under the 
file name synchronized with the log number. This allows you to check details of the parameter 
when the setting is changed. It is possible to check by the log output function. For log output 
function, refer to the recorder instruction manual. 

- Security logs cannot be deleted. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2.4 Electronic signature function 
Electronic signature in this device 

- This function is used to sign recorded measurement data. 
- Up to three users can sign a measurement data item. 
(Arbitrarily assign meanings to signatures and use them.) 
- You can sign a measurement data item multiple times with the same account. 
- Signatures cannot be canceled. 
- Use Ex.Sec Viewer to make a signature. (The recorder cannot be used to make a signature.) 

Input type setting ・Security log 
・Parameter file 

Record start 
・Security log 

Login A log is generated. 
・Security log 

A log is generated. 

A log is generated. 
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2.5 Signature data output function 
Signature data output function in this device 

- This function is used to print trends, instantaneous values, reports and audit trail data which 
signature data is added to. 

- This function can also output raw (binary) data to migrate it to a new PC or other device. You need 
Ex.Sec Viewer to view raw data. 

 

2.6 Data falsification/corruption detection function 
Data falsification/corruption detection function in this device 

- This function prohibits viewing of recorded measurement data that is falsified or corrupted. 
Because such measurement data cannot be validated, it is not allowed to check or sign the data. 

 

 



 3-1 

3.Operation 
 

3.1 Operation procedure 

3.1.1 Initial settings of recorder 
This section describes how to configure initial settings of recorder. 

 

 

Insert the SD card. 
 

Turn the power on. 

Enable the extended security function. 
Refer to Section 4.2.1, "Enabling the extended 

security function." 

Change input type and other settings. 
Refer to Section 4.2.6, " Changing Settings 

(Example: Changing the Input Type)” 
 
 

Log in. 
Refer to Section 4.2.2, " Login (when logout)" 

 
 

 

Log out. 
Refer to Section 4.2.6, "Logout” 

 
 

Register administrator accounts. 

Insert the SD card. 
The extended security function cannot be enabled 
without inserting the SD card. 

You must register one or more administrator 
accounts to enable the extended security function. 
* The recorder cannot be operated if administrator 
accounts expire. It is recommended to register two 
or more administrators. 

Enable the extended security function. 
The login operation is required to perform each 
operation and setting. In addition, record data is 
data for the extended security function. 

Register a user account. You can register accounts 
for which each operation or setting is restricted. 
You do not necessarily have to register user 

 

Configure each type of setting. 
For details about each type of setting item, refer to 
the manual of the recorder. 
*If the record type is set to other than "Max / 
Min", report printing becomes possible. 

It is recommended to log out as soon as you 
completes operations to prevent other persons 
from performing operations or settings. You can 
be logged out after a certain period. 

Register a user account with operation restriction. 
Refer to Section 4.2.4, " Register users with operation 

restrictions." 
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3.1.2 Initial settings of Ex.Sec Viewer 
This section describes how to configure initial settings of Ex.Sec Viewer. 
 
- Installation of support software 

You must install support software before using Ex.Sec Viewer. 
When you install support software, Data Viewer and Parameter Loader are installed at the same 
time as Ex.Sec Viewer. For details about installation of support software, refer to Section 5.1.4, 
"Installation." 
* Note restrictions such as the operating environment of your PC. For details about the operating 

environment, refer to Section 5.1.3, "Recommended operating environment." 
 
- About the authentication-key 

You must insert the authentication-key into a USB port to start Ex.sec Viewer. Insert the 
authentication-key attached as an accessory before starting Ex.sec Viewer. 
The authentication-key is recognized in an environment shown in Section 5.1.3, "Recommended 
operating environment." The LED is always on while the authentication-key is operating. For 
details about the authentication-key, refer to Section 5.1.6, "About the authentication-key." 

 
- Preparation of SD card reader 

Ex.Sec Viewer can import record data into PCs only from the SD card reader. Therefore, use the PC 
equipped with an SD card reader or connect an external SD card reader to the PC. 
Record data cannot be imported via network. 
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3.1.3 Normal operation of recorder 
An operation example of setting or operation in the recorder is shown below. 
For the timing of data output to the SD card, refer to Section 4.6 " Timing of data writing". 

 

Log in. 
Refer to Section 4.2.2, " Login (when logout)" 

Start recording. 
Refer to Section 4.2.7, " Start / stop recording 

(Output measured data to SD card)" 

Stop recording. 
Refer to Section 4.2.7, " Start / stop recording 

(Output measured data to SD card)" 
 

Log out. 
Refer to Section 4.2.3, "Logout” 

Check security logs. 
Refer to Section 4.2.8, " Check the audit trail 

(security log)” 
 

 

When the SD card is inserted, record data is output 
to the SD card when you stop recording. 

You can check logs on the recording 
start or stop time, other operations, and 
settings. 
 

It is recommended to log out as soon as 
you completes operations to prevent 
other persons from performing 
operations or settings. 

Make sure that SD writing is not in progress and 
remove the SD card. For details on how to remove 
the SD card, refer to Section 1.4 "About handling 
SD card". 
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3.1.4 Operation procedure in Ex.Sec Viewer 
An operation example of setting or operation in Ex.Sec Viewer (support software) is shown below. 

 

 

Start Ex.Sec Viewer. 
Refer to Section 5.2.1, " Start Ex.Sec Viewer” 

 

Import record data into the PC. 
Refer to Section 5.2.2, " Get record data to PC” 

 
 

Check audit trails. 
Refer to Section 5.2.4, 

 " Check and print the audit trail (security log)” 

Check and sign record data. 
Refer to Section 5.2.3,  

" Check and sign the recorded data” 
 
 

Print record data. 
Refer to Section 5.2.5, " Print the signed record data” 

Refer to Section 5.2.6, " ” 
 

Migrate record data to another PC. 
Section 5.2.7, "Migrating signed record data to another 

PC" 
 

Edit batch information for record data. 
Refer to Section 5.2.6, 

 " Edit and register batch information of recorded data” 
 

Check that the authentication-key is 
inserted before starting Ex.Sec Viewer. 
 

You can add batch information to record 
data to make the record data easy to 

 
 

You can check audit trails about settings 
and operations in the recorder. 
 

Check and sign record data. You can 
make a comment when signing the data. 
 

You can print recorded trend data, 
instantaneous value data, reports and 
audit trails. 

Perform this operation for example when you 
purchase a PC or move the folder because the 
HDD is full. This operation is not necessary at 
normal times. 
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3.2 Operational precautions 
Note the following points during operation. 

3.2.1 Recorder 
- You can start and stop recording only with the "REC" button. 
-When the administrator account is expired, the recorder can not be operated. We recommend that 

you register 2 or more accounts. 
-If you set the record type to other than "Max/Min" and record, it is possible to print reports such as 

daily reports and monthly reports. 
→ Please note that the report printing can not be performed for channels with the record type 
“Max/Min”. 

- Please insert the SD card and start recording. Since the overwrite function is turned off in the 
extended security mode, if recording is performed without inserting an SD card, recording stops 
when the internal memory capacity becomes full. 

- Each parameter in the recorder can be only changed in the recorder. 
-Even if it is set to "Binary + CSV" in the recording data format, the CSV file is not output. 

Please use Ex.Sec Viewer when you want to make CSV file 
- The following operations cannot be performed when the extended security function is enabled. 

1. Modification of each parameter, start/stop of recording, reset of accumulated data, recording of 
messages, and manual calibration of SNTP using the Modbus communication function. 

2. Modification of parameters via network using the parameter loader. 
3. Start/stop of recording using the data viewer. 
4. Start/stop of recording using the DI function. 

- Safely keep the password used when registering a user. If you lose the password, you can no longer log 
in. 

- Measurement data can be checked only with Ex.Sec Viewer when the extended security function is 
enabled. 

- Measurement data can be checked only with Data Viewer when the extended security function is 
disabled. 

3.2.2 Ex.Sec Viewer 
- Be sure to export record data before starting migrating it for example when changing the folder or 

rebuilding the environment (replacing the PC). 
 For details about how to export data, refer to Section 5.2.7, "Migrating signed record data to 
another PC." 
- The function to add comments to measurement data in Data Viewer is not provided. (You can make 

a comment when signing the data.) 
- When recording is incomplete (recording in progress or dmt, dst files are less than 50), importing 

recorded data may affect signature data and so on. For this reason, we recommend that you only 
import files that have been completely recorded. 

- Operation on virtual PC (Hyper-V, VMware etc.) is not guaranteed. 
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4.Recorder 
 

4.1 Overview 
 
- Initial settings 

Operation examples related to initial settings are shown below. 
No. Operation Description Reference 
1 Enabling the extended security function Setting the extended security 

function. 
*You must set up the extended 
security function before use. 

Section 4.2.1, 
”Enabling the extended security 

function” 

2 Register users with operation restrictions Register a user account with 
operation restriction. You can 
permit or prohibit each setting or 
operation for user accounts. 

Section 4.2.4, 
”Register users with operation 

restrictions” 

3 Permit electronic signature of user account You can permit the user account’s 
electronic signature. Note that 
electronic signatures can be made 
only in Ex.Sec Viewer (support 
software). 

Section 4.2.5, 
”Permit electronic signature of 

user account” 

4 Changing Settings (Example: Changing the Input Type) Change settings. 
* Report output is possible by 
setting the record type to other 
than "Max/Min". 

Section 4.2.6, 
”Changing Settings (Example: 

Changing the Input Type)” 

 
- Normal operation 

Operation examples during normal operation are shown below. 
No. Operation Description Reference 
1 Login (when logout) Perform the login operation. Section 4.2.2, 

”Login (when logout)” 
2 Logout Manually perform the logout 

operation. 
Section 4.2.3, 
”Logout” 

3 Start / stop recording (Output measured data to SD 
card) 

Start/stop recording. Section 4.2.7, 
”Start / stop recording (Output 

measured data to SD card)” 
4 Check the audit trail (security log) Check 1 to 1,000 past security 

logs. 
Section 4.2.8, 
”Check the audit trail (security 

log)” 
5 Resetting the password (In the case of password 

expired) 
Set a new password if the 
password has expired. 

Section 4.2.9, 
”Resetting the password (In the 

case of password expired)” 
6 Resetting the password (In the case of password forgot) Action if you forget the password. Section 4.2.10, 

”Resetting the password (In the 
case of password forgot)” 

 
- Settings and display 

You must set the following items in this device to use the extended security function. 
No. Settings and display Description Reference 
1 User registration Register an administrator or user 

account. 
Section 4.3.1, 
”User registration” 

2 Security mode Specify the security mode, how to 
log out, expiration date of a 
password, and other items. 

Section 4.3.2, 
”Security mode” 

3 Setting of each parameter Specify the input type as well as 
display, record, communication, 
and other settings. 

Recorder operation manual 

4 Security Log (Audit trail) Check the display of security logs. Section 4.3.4, 
”Security Log (Audit trail)” 
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- Files 

The following files are recorded and output when extended security is enabled. 

* For the timing of data writing, see Section 4.6 " Timing of data writing". 
No. File Description Reference 
1 Measurement data file Main and sub record measurement 

files. 
Section 4.5.1, 
”Measurement data file” 

2 User information file File that contains registered user 
information. 

Section 4.5.2, 
”User information file” 

3 Security log file Operation log automatically recorded 
when you perform some setting or 
operation. 1,000 past security logs are 
internally recorded. 

Section 4.5.3, 
”Security log file” 

4 Parameter log file Parameter file automatically recorded 
when you set parameters. 50 past 
parameter files are internally recorded. 

Section 4.5.4, 
”Parameter log file” 
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4.2 Operation 

4.2.1 Enabling the extended security function 
This setting is only required for the first time. 
It is recommended to register two or more administrator accounts. When two administrator accounts 
are registered, you can reset the password in case you lose it. 

Step 1: Inserting the SD card 
Open the cover of the button operation section. Press the SD card into the SD card insertion slot 
with the front side of SD card faced upward until it clicks as shown in the figure below. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Step 2: Turning the power on 
Connect the device to the power supply. There is no power switch. When you connect the device 
to the power supply, the device immediately starts up. Startup takes about 30 seconds. 
 

Caution 
 Always check the orientation of SD card. Inserting the SD card in the incorrect orientation 

may damage the SD card or recorder. 
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Step 3: Registering users 
Create administrator accounts. 
For details about user registration settings, refer to Section 4.3.1, "User registration." 
* You must create at least one administrator account. You cannot use the extended security 

function without creating an administrator account. It is recommended to create two 
administrator accounts. 

 
- Operations to open the user registration screen 
MENU button → System key → Security key → User Regist. key 
 
- To register a user 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 Safely keep the password used when registering a user. If you lose the password, you can no 

longer log in. 

Touch the Add key. 

Specify account information you want to register and 
touch the OK key. 
 
Setting example: 
User name : Administrator 
Arbitrary text : Bob (such as user name or title) 
Password  : 1234 
Entry for confirmation:1234 
Level  : administrator 

Caution 
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Step 4: Enabling the extended security function 
Enable the extended security function. 
Enable the extended security function in the security mode. 
For details about setting of security mode, refer to Section 4.3.2, "Security mode." 
*The extended security function cannot be enabled without inserting the SD card. 
 
- Operations to open the security mode screen 
MENU button → System key → Security key → Security Mode key 
 
- To enable the extended security function 
 

 

 

 

 

 

Setting is completed when you confirm 
that Security Mode becomes Extended 
Security and touch the OK key. 
 
Setting example: 
Security Mode: Extended Security 
How to Lock/Log out: Auto + Manual 
Password Time-Limit: 365 (days) 

Touch Security Mode on the security 
mode setting screen several times. 
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4.2.2 Login (when logout) 
This procedure is required when you change parameters, start recording or perform other operations. 

Step 1: Opening the login screen 
Open the login screen. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Step 2: Logging in 

Log in using the account you set up. 
 

 

 

 

 

 

 

 

 

 

 

Touch the screen or press the REC, 
MENU, or FUNC hard button. 
 
* While the extended security function is 

enabled, this screen is opened 
whenever you touch the screen or 
operate a hard button. 

Enter the user name and password and 
touch the Login key. 
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When the login session is completed, the name of the current login user appears as shown at the 
right bottom of the figure below. 
If the user name is long, the display is scrolled. 
 

 

 

 

 

 

 

 

 

 

 

 

 
 If you input mistake passwords in 10 times consecutive, your account will be locked and you 

will not be able to log in for 24 hours. In order to use the account again, you need to log in 
again after 24 hours, or reset the password with the administrator user. 

Warning 
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4.2.3 Logout 
When Auto + Manual is set to How to Lock/Log out, the user is automatically logged out if no 
operations are performed for five minutes. 
For details about how to lock or log out, refer to Section 4.3.2, "Security mode." 

Step 1: Manual logging out  

Manually log out. 
 

- Operations to open the manual logout screen 
MENU button → ExtendedSec. key 
 
- To manually log out 
 

Touch the Logout key. 
This completes the manual logout 
operation. 
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4.2.4 Register users with operation restrictions 

Step 1: Logging in as the administrator (at logout) 

Log in as the administrator (at logout). Only the administrator can edit, add, or delete user 
accounts. 
For details about login, refer to Section 4.2.2, "Login (when logout)." 
 

Step 2: Registering a user account with operation restriction 
For details about user registration settings, refer to Section 4.3.1, "User registration." 
* By default, it is prohibited to change all the setting values with a user account. 
 
- Operations to open the user registration screen 

MENU button → System key → Security key → User Regist. key 
 
- Procedure for registering a user account with operation restriction 

 

 

 

 

Touch the Add key. 

Set User to Level and touch the Select the 
item key. 
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Log out from the current login account, log in using the account you registered (Operator1 in the 
above case) and check the item you permit. 
 
Because you permit the input setting, the setting can be now changed as shown in the (left) figure 
below. 
If you prohibit the setting, the setting cannot be changed as shown in the (right) figure below. 

 

 

When you touch the Select the item key, 
the screen shown on the leftouchears. 
Touch the item you want to permit. 
 
Example: 
Permit the parameter input setting. 

A circle appears next to Input. 
Then, touch the Back key to return to the 
security user screen. 
* Touching the Back key does not 

complete selecting the item. 
 
When the security user setting screen 
appears, touch the OK key to complete 
setting. 
 



 4-11 

 

4.2.5 Permit electronic signature of user account 
* By default, it is prohibited to sign data with a user account. 
Perform the following operation when selecting the item you permit in Section 4.2.4, "Register 
users with operation restrictions." 

 

 
 
 

Touch the Select the item key. 

Touch the Trend key → Signature. 

A circle appears next to Signature. 
Then, touch the Back key to return to the 
security user screen. 
* Touching the Back key does not 

complete selecting the item. 
 
When the security user setting screen 
appears, touch the OK key to complete 
setting. 
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4.2.6 Changing Settings (Example: Changing the Input Type) 
Here, changing the input type is used as an example for description purposes. 
For details about setting the input type or other item, refer to the manual of the recorder. 
* Report output is possible by setting the record type to other than "Max/Min". 

Step 1: Logging in (at logout) 

Refer to Section 4.2.2, "Login (when logout)." 
 

Step 2: Changing the input type 

Change the input type of each input channel. 
* When you touch the OK key, the security log and parameter log are recorded. 
 For details about the security log, refer to Section 4.3.4, "Security Log (Audit trail)." 

For details about the parameter log, refer to Section 4.5.4, "Parameter log file." 
 
- Operations to open the input screen 
MENU button → Parameter key → Input key 
 
- To change the input type 
 

 

 

 

Touch the Input type key. 
When the following input type selection 
screen appears, select an arbitrary input. 

After completing setting the input type, 
touch the OK key. 
 
Setting example: 
Input type: K3 
(The burnout and RJC settings are enabled 
only when the input type is 
thermocouple.) 
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4.2.7 Start / stop recording (Output measured data to SD card) 
Check the following items before starting recording. 
 

Setting item Reference 
Recording cycle 

Recorder User’s Manual 
 

File recording cycle 
Each input or operation channel 
settings 
Record group or other display 
settings 
User registration Section 4.3.1, "User registration" 
Security mode Section 4.3.2,"Security mode" 
Signature function of user account Section 4.2.5,"Permit electronic signature of user account" 

 

Step 1: Logging in (at logout) 

Refer to Section 4.2.2, "Login (when logout)." 
 

Step 2: Starting recording 

 

 

 

 

 

 

 

 

 

 

 

Step 3: Stopping recording (outputting measurement data to the 
SD card) 

 

 

 

 

 

 

 

 

 

 

 

 

Press the REC button to start recording. 

Press the REC button. 
When you are prompted to confirm 
stopping recording, touch the Stop key or 
press the REC button again to stop 
recording. 
 
After recording stops, measured data is 
output to the SD card. 
* If the SD card is not inserted: 

Measurement data is automatically 
output after the SD card is inserted. 
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4.2.8 Check the audit trail (security log) 

Step 1: Logging in (at logout) 

Refer to Section 4.2.2, "Login (when logout)." 
 

Step 2: Checking audit trails (security logs) 

Check recorded audit trails (security logs). 
For details about the security log, refer to Section 4.3.4, "Security Log (Audit trail)" 
*Security logs cannot be checked while historical trends are displayed. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Security logs are displayed. 
Check the details of logs horizontally or 
vertically scrolling them. 
Touch the Update key to refresh the 
display with the latest record information. 
 

Touch the GRPH key on the trend screen 
multiple times. 

When event records are displayed, touch 
the DISP key twice. 
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4.2.9 Resetting the password (In the case of password expired) 

Step 1: Logging in (at logout) 

Refer to Section 4.2.2, "Login (when logout)." 
When you select a login user on the login screen, the following password reset screen appears. 
 

 

 

 

 

 

 

 

 

 

 

 

Step 2: Resetting the password 

 

 

 

 

 

 

 

 

 

 

 

 

Step 3: Logging in using the new password 

Log in using the password you registered at Step 2. 
 

 

 

 

 

 

 

 

 

 

Enter the old password and a new password. 
You must enter the new password twice for 
confirmation. 
 
Note that the following character string 
cannot be set as a new password. 

1. Same password as the old one 
2. Same password as the user name 
3. Password consisting of less than 4 letters 
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4.2.10 Resetting the password (In the case of password forgot) 
If you lose your user account password, you can reset your password by logging in as an administrator user. 
If you lose the password for the administrator account, you can perform the operation described in this 
section only when two or more administrator accounts are registered. If only one administrator account is 
registered, contact your dealer or our sales staff. 
 

Step 1: Logging in using the administrator account 

Refer to Section 4.2.2, "Login (when logout)." 
 

Step 2: Resetting the password for the account for which 
password you lost 

Reset or clear the password. 
Perform the setting on the user registration screen. 
 
- Operations to open the user registration screen 

MENU button → System key → Security key → User Regist. key 
 

Select the account for which password 
you want to reset and touch the Edit key. 

- To reset the password: Specify a new password in the red frame. (left figure) 
- To clear the password: Clear data from the red frame. (right figure) 
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- You can use the new password at the next login after resetting the password. (left figure) 
- The password setting screen appears at the next login after you clear the password. Specify an arbitrary 

password. (right figure) 
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4.3 Setting/Display 

4.3.1 User registration 
This section describes how to create, edit or delete users used at login. You also use the user 
name and password specified here in the support software (Ex.Sec Viewer). Up to 20 users can 
be registered. 

 
[Notes] - No settings may be changed while the process of recording is in progress. 

- Safely keep the password used when registering a user. If you lose the password, you 
can no longer log in. 

 

Table 4.1 List of Setting Items and Setting Values   
No. Item name Setting value Remarks 

(3)  User name Specify an arbitrary character string. 
(up to 16 one-byte characters) － 

(4)  Any letter Specify an arbitrary character string. 
(up to 16 one-byte characters) Can be omitted. 

(5)  Password Specify an arbitrary character string. 
(up to 32 one-byte characters) － 

(6)  Entry for 
confirmation 

Enter the same character string as that you entered 
as the password. 

 
(up to 32 one-byte characters) 

－ 

(7)  Level Administrator or user － 

(8)  Selection the item 
Select parameter settings, system settings, and 

other operation items you permit. 
 

This item is displayed only 
when User is set to Level. 

* By default, it is prohibited 
to change all the setting 

values. 
 

[How to set] 
Select the MENU button → System key → Security key → User Regist. key to open the 
setting screen. 

 

 

 
 
 
 
 
 
 
 
 

(1) Account list (2) Operation keys 

(3) User name 

(4) Any letter 

(6) Entry for 
confirmation 

(5) Password 

(7) Level 

(8) Selection of 
permitted items 
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(1) Account list 

Lists created users. Up to 20 users can be registered. 
(2) Operation keys 

To edit or delete a user, touch and select the user in [①Account list] and  
touch and select the Edit or Delete key. (The selected item is indicated in light blue.) 
To add a user, touch the Add key. When you touch the Edit or Add key, the security user setting screen 
(right figure above) appears. 

(3) Specifying the user name (up to 16 one-byte characters) 
Enter an arbitrary user name on the text entry screen and set it with the OK key. 

(4) Specifying arbitrary text (up to 16 one-byte characters) 
Enter an arbitrary user name on the text entry screen and set it with the OK key. (This setting can be 
omitted.) 
This is the description of each user and displayed in support software (Ex.Sec Viewer) as well. For 
details about where this item is displayed, refer to Section 5.2.3, "Checking and signing record data." 

(5) Password (up to 32 one-byte characters) 
Set the account password. 

(6) Entry for confirmation (up to 32 one-byte characters) 
Confirm the password. Enter the same character sting as that in [⑤Password]. 

(7) Level 
Set the account level and restrict each setting and operation. 
Administrator : Can perform all the settings and operations. Only the administrator can edit, add, or delete 

User Regist. The administrator can also reset the password for the administrator or user 
account for example if the user forgets the password. For details about how to reset the 
password, refer to Section 4.2.10“ Resetting the password (In the case of password 
forgot)." 

User : Settings and operations can be restricted. Restrictions can be set in [⑧Selection of permitted items]. 
(8) Selection of permitted items 

Specify settings and operations available to the user account. 
When you touch the item you permit, a circle appears next to that setting item. 
You can use the All permit or No permit key to specify the setting for Parameter, Systems, Records, 
Trends, or Hard button, respectively. When you touch the All permit key with Parameter touched, all the 
settings and operations in Parameter are permitted. The permission status of other items is not changed. 
For the list of items you can permit, refer to Appendix 1, "List of Items You Can Permit." 
* By default, it is prohibited to change all the setting values. 
 
For details about a user setting example, refer to Section 4.2.4, "Register users with operation restrictions." 
 

 

[Notes] 
The following password cannot be set. 

1. Same password as the old one (only when resetting the expired password) 
2. Same password as the user name 
3. Password consisting of four or less than letters 
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4.3.2 Security mode 
This section describes how to set the security mode. You can use the extended security mode 
performing this setting. For details about how to set, refer to Section 4.2.1, "Enabling the 
extended security function." 

 
[Notes] No settings may be changed while the process of recording is in progress. 

 

Table 4.2 List of Setting Items and Setting Values   

No. Item name Setting value Remarks 

(1)  Security mode OFF, key lock, extended security － 
(2)  How to lock or log out Manual or Auto + Manual － 

(3)  Password expiration 
period 1 to 365 (days) － 

 

[How to set] 
Select the MENU button → System key → Security key → Security Mode key to open the 
setting screen. 

 

 

 

 

 

 

 

 

 

 

 

 

 

(1) Security mode 
Set the security mode. 

OFF  : The security function is not used. 
Key Lock  : The key lock function is used. 

For details about the key lock function, refer to the manual of the 
recorder. 

Extended Security : The extended security function is used. 
For details about the extended security function, refer to Chapter 2, 
"Extended Security Function." 
* When the extended security is set, measurement data is output for the 

extended security function. The data cannot be checked in the 
standard support software (Data Viewer). Use the support software 
dedicated to the extended security function (Ex.Sec Viewer). 

(2) How to lock or log out 

(3) Password expiration period 

(1) Security mode 
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(2) How to lock or log out 

Select how to lock or log out. 
Manual  : The user can only manually lock or log out the device. 
Auto + Manual  : The device is locked or logged out if not operated for five minutes. 

The user can also manually lock or log out the device. 
(3) Password expiration period 

Specify the password expiration period. You must set a new password at login after the 
specified expiration period. The password reset screen is displayed as shown below. For details 
about resetting the password, refer to Section 4.2.9, "Resetting the password (In the case of 
password expired)." 

 

 

 

 

 

 

 

 

 

 

 

 

4.3.3 Setting of each parameter 
You can set each type of parameter after login. 
For details about setting each type of parameter, refer to the manual of the recorder. 

* Report output is possible by setting the record type to other than "Max/Min". 
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4.3.4 Security Log (Audit trail) 
This section describes how to display the logs for each setting or operation. You can record up to 
1,000 user operations such as modification of setting values or start/stop of recording as timestamped 
logs. When the number of log records exceeds 1,000, the oldest log record is overwritten and updated. 
Note that security logs cannot be deleted. 
When you change a setting value, the parameter file immediately after change is saved under the file 
name synchronized with the log number. 
 
[How to display] 

Touch the GRPH key on the real-time trend screen multiple times and touch the DISP key on the event 
record screen several times. 
Touch the Update key to refresh the display with the latest record information. You can check the whole 
log by using the vertical and horizontal scroll bars. 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

(1) Log recording date/time 
Displays the date/time when the setting or operation is performed. 

(2) Operator 
Displays the account name used to perform the setting or operation. 

(3) Log number 
Displays the number for each setting or operation log ([000] to [999]). 
The parameter log file corresponding to the log number is generated during setting. 
For details about the parameter log file, refer to Section 4.5.4, "Parameter log ." 

(4) Setting and operation logs 
Displays the performed setting or operation. 
For the list of logs, refer to Appendix 2, "List of Security Logs." 

(1) Log recording date/time (2) Operator (4) Setting and operation logs (3) Log number 
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4.4 SD card folder structure 
This section describes folder configuration when the extended security function is enabled. 
The folder dedicated to extended security is created when you start or stop recording. 
The folder configuration is shown below. 
 

[Folder configuration example] 

[Recorder] --+-- (1) [Data] 
+-- (2) [Cap] ---- Capture_0000.bmp 
+-- (3) [Etc] ---- String_List.txt 
+-- (4) [Prm] ---- Setup.dps 
+-- (5) [EXSEC_XXXXXXXXXX (manufacturing number)] 
 
 

[EXSEC_ XXXXXXXXXX (manufacturing number)]  
| 
+-- (6) [YYMMDDHHmmss] --+-- xxxx_YYMMDDHHmm.secm 
|                    +-- xxxx_YYMMDDHHmm.dmt 
|                   +-- xxxx_YYMMDDHHmm.dme 
|                    +-- xxxx_YYMMDDHHmm.dmc 
|                   +-- xxxx_YYMMDDHHmm.secs 
|                   +-- xxxx_YYMMDDHHmm.dst 
|                   +-- user.dat 
|                    +-- security_log.dat 
| 
+-- (7) [Prm] --+-- nnn_YYMMDD.dps 

+-- nnn_YYMMDD.dps 
 

 

(1) [Data] 
Measurement data is stored only when the extended security function is disabled. 
For details about folder configuration when the extended security is disabled, refer to the manual of 
the recorder. 

(2) [Cap] 
Images captured with the screen capture function are saved in the bitmap format (.bmp). Up to 100 
images can be saved. 
For details about screen capture, refer to the manual of the recorder. 

(3) [Etc] 
The character string table that can be used with the List key on the text entry screen (.txt) or other data 
is saved. 

(4) [Prm] 
The parameter settings file (.dps) set with this device is saved. When you save parameters with the 
Prama Save key, the data is saved in this folder. For details about saving setting values, refer to the 
manual of the recorder. 
The dps file saved in this folder can be read or written with this device. 
Store the file generated with the parameter loader in this folder. 
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(5) [EXSEC_XXXXXXXXXX (manufacturing number)] 

Folder dedicated to the extended security. 
The folder is created in the format that allows the user to identify the recorder. That is, a 
manufacturing number is added to the folder name. 
The record data folder and parameter log folder are created in this folder. 

 
(6) [YYMMDDHHmmss] 

Record data folder. The measurement data folder contains measurement data files, user information 
files, and security log files. For details about each file, refer to Section 4.5.1, "Measurement data file," 
Section 4.5.2, "User information file," and Section4.5.3, "Security log file." 
The folder is named using the recording start date/time. The folder name conventions are as shown 
below. 

 
Naming conventions of record data folder 

Folder name: YYMMDDHHmmss (record starting date/time) 
YY: Two-digit year (00 to 99) 
MM: Two-digit month (01 to 12) 
DD: Two-digit day (01 to 31) 
HH: Two-digit hour (00 to 23) 
mm: Two-digit minute (00 to 59) 
ss: Two-digit second (00 to 59) 

 
(7) [Prm] 

Parameter log folder. 
The parameter log file is created in this folder. 
For details about the parameter log file, refer to Section 4.5.4, "Parameter log ." 
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4.5 File 
This section describes details of record data such as measurement data. 
For details about how to output record data to the SD card, refer to Section 4.2.7, "Start / stop recording 
(Output measured data to SD card)." For details about folder configuration when outputting data to the SD 
card, refer to Section 4.4, " SD card folder structure." 

 

 

 

 

 

 

 

4.5.1 Measurement data file 
There are files that contain recorded measurement data. 
There are the following six types of measurement data files: 
The naming conventions of each file are as shown below. 
 
 
 
 
 
 
 
 
 
- Main record management file 

File to record when recording of (main) trend data started and ended as well as link information. 
A single secm file can be used to manage up to 50 dmt files. 
(If 50 or more dmt files are created, a new secm file is created.) 
File name: xxxx_YYMMDDHHmm.secm 
Extension: secm 

- Main record trend file 
(Main) measurement data file divided at the file recording cycle. 
File name: xxxx_YYMMDDHHmm.dmt 
Extension: dmt 

- Main record event file 
History file to record alerts, messages and other events. 
File name: xxxx_YYMMDDHHmm.dme 
Extension: dme 

- Main record comment file 
Data file for the comment function. 
File name: xxxx_YYMMDDHHmm.dmc 
Extension: dmc 

 
 - All of the files are required record data. Do not delete them. 

Do not rename files in any case. Failure to follow this instruction makes it impossible to view record data. 

Do not edit files in any case. Failure to follow this instruction makes it impossible to view record data. 

Naming conventions of each file 
YY: Two-digit year (00 to 99) 
MM: Two-digit month (01 to 12) 
DD: Two-digit day (01 to 31) 
HH: Two-digit hour (00 to 23) 
mm: Two-digit minute (00 to 59) 
ss: Two-digit second (00 to 59) 
xxxx: Four-digit record management file number (0000 to 0999) 

Caution 
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- Sub record management file 
File to record when recording of (sub) trend data started and ended as well as link information. 
File name: xxxx_YYMMDDHHmm.secs 
Extension: secs 

- Sub record trend file 
(Sub) measurement data file divided at the file recording cycle. 
File name: xxxx_YYMMDDHHmm.dst 
Extension: dst 
 

4.5.2 User information file 
User information file registered when the user is registered. 
File name: user.dat 
Extension: dat 
 

4.5.3 Security log file 
File that stores information about 1,000 security logs. 
File name: security_log.dat 
Extension: dat 
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4.5.4 Parameter log file 
File that contains information about parameters set in the past. This file is internally generated for 
example when you select the input type. The parameter log file is not generated when an operation 
not related to parameters (such as start of recording) is performed. 
The recorder contains information about up to 50 past parameters. When 50 or more parameter log 
files are recorded, the oldest file is overwritten and updated. 
When you setting parameter, a parameter file associated with security logs is recorded. This 
parameter file is output to the SD card with measurement data when recording stops. When the SD 
card contains the same parameter file, that parameter file is neither saved nor overwritten. The created 
parameter file can be checked using the support software (parameter loader). 
 

 

File name: nnn_YYMMDD.dps 
Extension: dps 
 

 

 

 

The relationship between security logs and parameter log files are shown below. 
 

- Security log 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
- Parameter log file in the SD card folder 

Parameter log files are created under 
the names that contain the set log 
numbers [807] to [810], [813] to 
[817] as the first three letters. 

Naming conventions of parameter log file 
Folder name: nnn_YYMMDD (when recording the 

parameter file) 
YY: Two-digit year (00 to 99) 
MM: Two-digit month (01 to 12) 
DD: Two-digit day (01 to 31) 
nnn: Three-digit security logs number (000 to 999) 
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4.6 Timing of data writing 
First of all, recorded data is preserved in an internal memory, and it is automatically written on the 
SD card in each timing. The timing of writing data is shown below. (Refer to item 4.4 “ SD card 
folder structure” for format of record file.) 

(1) When recording stops 
(2) When you insert an SD card (when there is non-outputted record data in internal memory) 
(3) Per file recording cycle 

  

 

 

 

[Notes] 
- Never remove the SD card while "File writing" is displayed. 
- Please insert the SD card and start recording. Since the overwrite function is turned off in the 

extended security mode, if recording is performed without inserting an SD card, recording 
stops when the internal memory capacity becomes full. 
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5.Ex.Sec Viewer – OPERATION – 
 

5.1 Overview 

5.1.1 Introduction 
Chapters 5 and 6 describe how to install and operate Ex.Sec Viewer. Be sure to carefully read this 
document before use. 

5.1.2 About Ex.Sec Viewer 
Ex.Sec Viewer is support software with which you can check, sign and print record data. 
As this is optional software, the authentication-key is required to use it. 
Note that this software does not start up unless the authentication-key is inserted into the PC. 

5.1.3 Recommended operating environment 
- Computer with (32-bit or 64-bit) Microsoft Windows 7 ,8.1 or 10 installed 
- Hard disk with 500 MB or larger free space 
- RAM capacity required by the OS to normally operate 
- Memory card (SD card) (Recommended cards: 1-32GB card from Panasonic or 1-32GB card - 

from SanDisk or 1-32GB card - from HAGIWARA Solutions) 
- PC from a manufacturer (This software may not operate on a home-built PC or shop brand PC.) 
- Printer driver and printer supported by your OS 
- Mouse and keyboard supported by your OS 
- Port for Ethernet communication (10BASE-T, TCP/IP protocol) 
- CD-ROM drive x 1 
- Display resolution: 1024 × 768 pixels (XGA) or more 
- USB port 
- SD card reader 
- Virtual PC (Hyper-V, Vmware etc.) is not covered by warranty. 

5.1.4 Installation 
To install this software, perform the following procedure. Three support software applications (Ex.Sec 
Viewer, Data Viewer, and Parameter Loader) are installed at the same time. 
 

1) If other application software programs are open, terminate all of them. 
2) It the data viewer has been already installed, delete it from “Add/Remove Programs” on Control Panel. 
3) Set CD-ROM in the personal computer drive. 
4) The menu is automatically displayed. Follow the instructions on the screen. If the menu is not 

displayed, please start “index.htm” that CD-ROM drive has. The menu for the installation is 
displayed, and please installs it according to the instruction of the screen. The Data Viewer and 
the Parameter Loader are installed at the same time. 

* When installing the software, it may be necessary to install ".NET Framework". In that case, please 
install the software after installing ".NET Framework". When installing the .NET Framework 
attached to the CD on Windows 7, please install after updating the OS to the latest state. 
Windows 8.1 / 10 is already installed, so installation is not required. 
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(1) When you start the installer, the following screen is 

displayed. Please click the “Next”. 

(3) Use the default options, or select the installation folder 

and the target user(s). Proceed by clicking “Next”. 

(2) Please read the license agreement carefully and if you 

agree, please select “I Agree” and click the “Next”. 

 

(4)  Preparation for installation is now complete. 

Click “Next” to start installation. 

(5)  When installation is completed, the following 

message is displayed. Click “Close” to end installation. 
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5.1.5 Uninstallation 
To uninstall this software, perform the following procedure. Three support software applications 
(Ex.Sec Viewer, Data Viewer, and Parameter Loader) are uninstalled at the same time. 
- Windows 7 
Select [Start] -> [Control Panel] -> [Programs and Features]. 

- Windows 8.1 
Right-click the Windows button and select [Control Panel] -> [Programs and Features]. 

 
- Select VGR-B100 from the list and click “Uninstall”.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

- When the following message appears, press “Yes” to uninstall the software. 
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5.1.6 About authentication-key 
- What is an authentication-key? 

The authentication-key is a USB dongle required to use Ex.Sec Viewer. 
The authentication-key is recognized not as a mass storage such as USB 
memory but a human interface device. Therefore, the 
authentication-key can be used on a protected PC. In addition, because 
a dedicated driver is not required, this software is recognized in the 
environment described in Section 5.1.3, "Recommended operating 
environment" When the authentication-key is inserted for the first time, 
the LED flashes for several seconds and the standard Windows driver is 
installed. After installation, the authentication-key is recognized as 
"USB DONGLE." (The device can be checked with "Devices and 
Printers" in Control Panel.) 

 
- How to use the authentication-key 

Insert the authentication-key into a USB port before starting Ex.Sec Viewer. If the inserted 
authentication-key cannot be verified, the following error is displayed and the software does not operate. 

 

 

 

 

 

 

- Light-up patterns of authentication-key LED 
 

- When the LED is lit:  
Indicates that the dongle is normally operating.  
 
- When the LED is flashing: The USB port or driver may not normally function or the dongle may be 
defective. 
 
- When the LED is off and the "The USB device is found" message is output:  
The dongle may be defective or connection failure or malfunction of USB port is suspected. 
Refer to Chapter 7, "Troubleshooting." 
 
How to check the operation of USB port:  
Normally, when the authentication-key is connected to the PC for the first time, the "The USB device is 
found" message is displayed and the driver is installed. If installation of driver does not start, an 
incorrect USB controller driver may be installed, the USB may be disabled on the CMOS, or the USB 
port hardware may be defective. Check whether other USB products such as the USB mouse normally 
operate. When USB ports normally operate, the authentication-key may be defective. Refer to Chapter 7, 
"Troubleshooting." 
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5.2 Operation 
This section describes how to import, sign and print record data and other procedures. 

 

5.2.1 Start Ex.Sec Viewer 

Step 1: Inserting the authentication-key into the PC 
Insert the included authentication-key into a USB terminal on the PC. 

Step 2: Starting Ex.Sec Viewer 
The following shortcut icon is automatically created on the desktop during installation. 
Double-click the icon to start Ex.Sec Viewer. 
 
 
 
 
 
 
 
You can also start the application by clicking it in "VGR-B100" in All Programs. 
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5.2.2 Get record data to PC 

Step 1: Inserting the SD card into the PC 
Insert the SD card which measurement data was output to into the PC. 
For details about how to output measurement data to the SD card, refer to Section 4.2.7, 
"Starting/stopping recording (outputting measurement data to the SD card)." 
 

Step 2: Importing record data 

 

 
 

 

Click the "Ex.Sec" button to open the 
extended security data list screen. 
Click the "Get record data" button. To delete 
the imported record file, select the check box 
(  ). 
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Click the part in the red frame to display the 
manufacturing numbers of recorders from 
which data was imported. 
When you click the recorder from which 
data was imported, the record data list 
appears. 
 
Imported record data is saved in the folder 
specified in "Extended security save 
destination folder" in "Option" in the View 
menu. For details about option setting, refer 
to Section 6.5, "Option". 

The folder reference screen appears. 
The "EXSEC_XXXXXXXXXX 
(manufacturing number)" folder is a file that 
contains record data. Click the folder above 
this folder ("Recorder" in this case) and 
click the "OK" button. 

Click the "OK" button. 

When importing starts, the progress bar 
appears. 
When the progress bar disappears, importing 
is completed. 
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The imported data is displayed as shown below. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

(1) Serial No. 
Displays the manufacturing number of selected recorder. 

(2) Record type 
Displays the type of record data recorded with the recorder. There are main records and sub 
records. 

(3) Batch 
It is possible to add arbitrary name as "batch " to imported recording data. Please use it to 
register your test status and remarks. For how to register, refer to Section 5.2.8 "Register and 
edit batch information of recorded data". 

(4) Recording time information 
Recording start time and recording stop time are displayed. When the recording is incomplete, 
the time until the captured data is displayed at the recording stop time. 

(5) Signature information 
The signature status, signed user name, signed time are displayed. 

 

Step 3: Adding detailed recorder information and batch information 
In this software, memos can be added to the recorder from which data was imported as detailed 
information. 
For details about how to add a memo, refer to Section 5.3.2 D) "Recorder list" 
Batch information can be added as well. For details about how to add batch information, refer to 
Section5.2.8, "Register and edit batch information of recorded data." For details about batch 
information, refer to Section5.3.2 E), "Edit batch information" 

(1) Serial No. (2) Record type (3) Batch (4) Recording time information (5) Signature information 
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5.2.3 Check and sign the recorded data 

Step 1: Displaying record data  
 

 

 

 

 

 

 

 

 

 

 

 

 

 

Select record data you want to display and click the "View" button. 
An arrow is displayed at the left edge of the currently selected record data. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Click the part in the red frame to display 
the manufacturing numbers of recorders 
from which data was imported. 
When you click the recorder from which 
data was imported, the record data list 
appears. 
 
If the list is not displayed, import record 
data according to Section 5.2.1, "Start 
Ex.Sec Viewer". 
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When login authentication is successful, you can see record data measured in the recorder. 
For details about how to perform each operation when displaying record data, refer to Chapter 6, " 
Ex.Sec Viewer –CONTROL-" 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The login authentication screen appears. 
Enter the user name and password used in 
the recorder and click the "OK" button. 
* Both the user name and the password 
are case sensitive. 
 
You can select or type the user name. You 
can change how to specify the user name 
from Option settings. For details about 
Option settings, refer to 6.5, "Option". 
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Step 2: Signing record data 
 

 

 

 

 

 

 
Click "Sign 1," "Sign 2" or "Sign 3" on the 
toolbar. 
"Sign 1," "Sign 2" and "Sign 3" in 
"Extended security" within the menu have 
the same function. 
Here, the signature of "Sign 1" is used as an 
example for description purposes. 

The login authentication screen appears. 
Enter the user name and password used in 
the recorder and click the "OK" button. 
* Both the user name and the password are 
case sensitive. 
 
You can select or type the user name. You 
can change how to specify the user name 
from Option settings. For details about 
Option settings, refer to 6.5, "Option". 

The signature screen appears. 
Select Pass or Fail and enter an arbitrary 
comment. Up to 52 one-byte characters can 
be entered. 
If the signature is correct, click the "OK" 
button. 
The user name displayed here is "User name 
+ Any letter". 

 Caution  
・It can’t be canceled after signature. Please sign carefully. 
・The signature is not for each record group unit. The signature will be all groups at once. 
・The signing order and other items are not restricted. The customer can arbitrarily assign 

meanings to them. For the signature example, see Section 5.3.4 "Signature" 
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If signing is completed, check the result of signature on the [Sign] tab in Event Summary or "Sign 1" 
in Extended security on the menu, for example. 
 
Event Summary 
 

 

 

 

 

 

 

 

 

 

 

 

Extended security menu 

The final confirmation message appears. 
If there are no problems, click the "OK" 
button. 
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5.2.4 Check and print the audit trail (security log) 

Step 1: Displaying (signing) record data 
Display record data. 
For details about how to display data, refer to Section 5.2.3, "Check and sign the recorded data." 
 

Step 2: Checking audit trails (security logs) 
With record data displayed, click the "Sec.Log" button or "Display Security Logs" on the 
Extended security menu. For details about Security log, refer to Section 5.3.6, "Security log 

display". 
 

 

 

 

 

 

 

 

 

 

 

 

Security logs are displayed as shown below. 
In addition, you can check the parameters corresponding to the security log. When clicking the 
clickable "Display parameter" button in the red frame, the support software "Parameter loader" is 
activated and the target parameter can be confirmed. 
(The security logs display can be vertically zoomed in or out. To zoom in or out the display, adjust 
the window by dragging the edge.) 
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STEP 3：Printing audit trails (security logs) 
An audit trail can be printed. 
You can print from "Print", "Preview" in Security log display or "Security log Print" and "Security 
Log Print Preview" in File Menu. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

When you click Preview, a print preview of the following security log is displayed. 
When “print” is clicked, the printer setting window is displayed, please make settings and execute 
printing.Note that signature information is not printed in security log printing. 
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5.2.5 Printing signed record data 

STEP 1：Displaying (signing) record data 
Display record data. 
For details about how to display data, refer to Section 5.2.3, "Check and sign the recorded data" 
Printing is performed for each recording group unit, and the data of the recording group currently 
being displayed is printed. Please select the recording group to be printed from the following 
(group change tab) and then print. 
 

 

 

 

 

STEP 2：Print trend data 

 

 

 

 

 

 

 

Click "Trend Print" or "Trend Print 
Preview" in the file menu. 
Here, we will explain "Trend print 
preview" as an example. For trend print, 
refer to Section 6.3.1 "Trend print". 
 
* When printing, we recommend that you 
execute trend print preview, check the 
format to be actually printed, and then 
print. 
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A print preview of the trend is displayed. 
The print screen with the header and footer added is displayed.It is also possible to set the title of 
the graph and ON/OFF of the page number within the option. For details about option, refer to 
Section 6.3.1, "Print options" 

After checking the print format, click the 
"Print" button. 
After that, please make printer settings 
and execute printing. 
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STEP 3：Print instant value data 
 

Click "Instant value print" in the file 
menu. 

Instantant value print setting window is 
displayed. 
You can make settings such as "Print 
direction", "Margin", "Number of print 
columns per page", etc., and adjust the 
number of prints. In addition, it is 
necessary to set the setting of "ON/OFF of 
the page number" and "Graph title" here. 
Make various settings and click either 
"Print" or "Print preview". For details 
about Instant value print setting, refer to 
Section 6.3.2 A), " Instant value print 
setting ". 
* When printing, we recommend that you 
execute trend print preview, check the 
format to be actually printed, and then 
print. 
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The instant value print preview window is displayed. 
The print window with the header and footer added is displayed. Margin setting on the preview 
window is possible. Changing the margin will update the preview window. If you want to set 
instant value printing again, please click the "× (Close)" button in the upper right. 
 

 

 

 

 

 

 

After checking the print format, click the 
"Print" button. 
A print confirmation message will be 
displayed. If there is no problem with the 
printing direction, paper size, print area, 
number of prints etc, click "OK" and 
execute printing. 
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5.2.6 Display and print the report (It supports since Ver.2.10) 
 

 

 

 

 

STEP 1：Displaying (signing) record data 
Display record data. 
For details about how to display data, refer to Section 5.2.3, "Check and sign the recorded data" 
Printing is performed for each recording group unit, and the data of the recording group currently 
being displayed is printed. Please select the recording group to be printed from the following 
(group change tab) and then print. 
 

 

 

 

 

STEP 2: Print the report 

 
 

Click "Print Report" in the file menu. 

 Caution  
Note that channels for which the record type is set to "Max/Min" can not be output as a report. 
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The report print setting window is displayed. 

Daily and monthly reports can be printed. 

Set the “Print Direction”, “Margin”, etc., select the report type you want to print, and specify the range. In 

addition, you need to set the settings of "ON/OFF of the page No." and "Graph title" here. 

For details on report print settings, refer to Section 6.3.4 "Report Print (Ver. 2.10 or later)". 

※ When printing, it is recommended to execute a print preview and check the format actually printed 

before printing.  
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The report print preview window is displayed. 

The print window with the header and footer added is displayed. Margin setting on the preview window is 

possible. Changing the margin will update the preview window. If you want to set report print again, please 

click the "× (Close)" button in the upper right. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

After checking the print format, click the 
"Print" button. 
A print confirmation message will be 
displayed. If there is no problem with the 
printing direction, paper size, print area, 
number of prints etc, click "OK" and 
execute printing. 
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5.2.7 Display and print the Max. /Min. /Ave. for a specified period  

(For Ver. 2.10 or later) 
 

 

 

 

 

 

 

 STEP 1：Displaying (signing) record data 
Display record data. 
For details about how to display data, refer to Section 5.2.3, "Check and sign the recorded data" 
Printing is performed for each recording group unit, and the data of the recording group currently 
being displayed is printed. Please select the recording group to be printed from the following 
(group change tab) and then print. 

 

 

 
 

 

STEP 2：Display the Max. /Min. /Ave. for a specified period  
 

 
Click "Max, Min, Average" in the display 
menu. 

 Caution  
If the record type of the channel recorded by the main unit is "Max / Min", it is calculated as follows. 

Max.: Calculated based on the "Max" data of the specified period. 

Min.: Calculated based on the "Min" data of the specified period. 

Ave.: Calculated as ("Max" + "Min") / 2 of the specified period. 
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The setting window of Max./Min./Ave. is 

displayed. 

Data, CH, and specify the data output range. 

Also, when printing after display, please set 

the item to be printed, the presence or 

absence of the page number, and the graph 

title. 

After setting is complete. Click on the "OK" 

button. 

The calculated data of the specified period is 

displayed. 

If you want to print, please click "Print" or 

"Print Preview". 

*When printing, it is recommended to execute 

a print preview and check the format actually 

printed before printing. 
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5.2.8 Register and edit batch information of recorded data 

Step 1: Register batch information 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Step 2: Edit batch information 
The registered batch information can be modified / edited. Please edit with the same operation as 
registering batch information. 

 

Click the "Edit" button. 

When you click the recorder selection 
button enclosed in red frame, the 
manufacturing numbers of recorders from 
which data was imported are displayed. 
When you click the recorder from which 
data was imported, the record data list 
appears. 
 
If the list is not displayed, import record 
data according to Section 5.2.2, "Get 
record data to PC" 

Double-click the batch information field 
for the record data you want to register 
and enter batch information. When you 
complete entering the information, click 
the "Save" button. Batch information is 
saved. Up to 64  one-byte characters can 
be entered for batch information. 
 
* Other buttons cannot be clicked until 
you click the "Save" or "Cancel" button. 
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5.2.9 Migrate the signed record data to another PC 
Perform this operation when purchasing a new PC or changing the environment for other reasons. 
(Usually, you do not have to perform the procedure in this section.) 

Step 1: Exporting record data 
Output record data to another folder. You can output the data to an arbitrary folder. Record data in 
the output source folder is not deleted. The output source folder is the folder specified in 
"Extended security save destination folder" in "Option settings" in the View menu. For details 
about option setting, refer to Section 6.5, "Option". 
This section describes how to output data to the "RECORD_DATA" folder. 
For details about export, refer to Section 5.3.2 I), "Export." 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The screen as shown on the left 
appears. Select an arbitrary export 
destination (here, 
"RECORD_DATA") and click the 
"OK" button. 

Click the "OK" button. 

Exporting starts and the progress bar 
appears. 
When the progress bar disappears, 
exporting is completed. 

Click the "Export" button at the right 
bottom. 
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Step 2: Importing record data 
Import record data to the folder used in Ex.Sec Viewer. This section explains how to import from 
the folder "RECORD_DATA" exported in STEP 1. Import record data from the folder specified in 
"Extended security save destination folder" in "Option settings" in the View menu. Record data in 
"RECORD_DATA" is not deleted.For details about import, refer to Section 5.3.2 J), "Import” 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Click the "Import" button at the right 
bottom. 

The folder reference screen appears. 
The "EXSEC_XXXXXXXXXX 
(manufacturing number)" folder is a file 
that contains record data. Click the 
folder above this folder 
("RECORD_DATA" in this case) and 
click the "OK" button. 

Importing starts and the progress bar 
appears. 
When the progress bar disappears, 
importing is completed. 

Click the "OK" button. 
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5.3 Setting/Display 

5.3.1 Basic display 
This is the screen that appears when Ex.Sec Viewer starts up. 
This screen displays the menu and toolbar. In order to Import and display measurement files, you first 
need to display extended security data list. For the extended security data list, refer to Section 5.3.2 
"Extended security data list display". 
For details about the menu, refer to Section 5.4, "Menu" 
For details about the toolbar, refer to Section 5.5, "Toolbar" 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Menu Toolbar 
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5.3.2 Extended security data list display 
This screen appears when you click "Extended security data list" in the File menu on the basic screen 
or the "Ex.Sec" button on the toolbar. You check, sign, print record data or perform other operations 
from this screen. Each button and function is described below. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Letter Button or function Description 
A) Data list List of record data in the selected recorder. 
B) Get record data Use this button to import measurement data recorded with the recorder to the PC. 
C) Recorder selection Use this button to select the recorder you want to check and list record data. 
D) Recorder list Use this button to Displays the list of recorder imported in the PC. 

E) 
Batch information 
editing 

Use this function to add batch information to imported record data. 

F) Display item setting Use this button to display or hide items displayed in the data list. 

G) Filter 
Use this function to filter record data displayed in the data list and display only 
necessary data. 

H) View Use this button to display record data. 

I) Export 
Use this button to copy imported record data and signed record data to another 
folder. 

J) Import 
Use this button to copy data in the folder copied by the export operation to the 
import destination folder. 

 

B) Get record data 

D) Recorder list 

C) Recorder selection 

E) Batch information editing 

F) Display item setting 

G) Filter 

H) View 
J) Import 

A) Data list 

I) Export 
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A) Data list 

List of record data in the selected recorder. 
This list displays record data imported into the PC. You can also sort record data by item by clicking 
the item in the red frame. The latest record data is displayed first before sorting. The items displayed in 
the list can be omitted in F) “Display item".  
The background color changes depending on the state of the recorded data. For details, refer to Section 
5.3.7 "Display and operation in each state of the recorded ". 

 

 

 

 

 

 

 

 

 

 

 
No. Item Description 
1 Manufacturing 

number 
Displays the manufacturing number of selected recorder. 

2 Record type Displays the type of record data recorded with the recorder. 
There are main records and sub records. 

3 Batch information Displays batch information. 
Batch information can be arbitrarily added. For details on how to 
register batch information, refer to Section 5.2.8 "Register and edit 
batch information of recorded data". 

4 Recording start 
time 

Displays when recording started. 

5 Recording end 
time 

Displays when recording ended. 

6 Sign status 
(signature) 

Displays the sign status. Pass, Fail, or Not signed is displayed. 

7 User name 
(signature) 

Displays the name of the user who signed data. 

8 Signing date/time 
(signature) 

Displays the date/time when the user signed data. 
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B) Get record data 

Get record data is the button to import information such as measurement data recorded with the 
recorder to the PC. 
Imported record data is saved in the folder specified in "Extended security save destination folder" 
in "Option settings" in the View menu. For details about Option settings, refer to Section 6.5 
"Option". 
 
[Operation] 

When you click the "Get record data" button, the following window to select the imported folder 
appears. To import measurement data recorded in the recorder, select "Recorder" in the SD card 
and click the "OK" button. Select the "□Delete the original file." check box to delete the original 
data after importing it. 
For details about how to import data, refer to Section 5.2.2, "Get record data to PC." 

 

 

 

 

 

 

 

 

 

 

 

 

C) Recorder selection 

Use this button to Recorder selection of which record data you want to display. 
You can check the serial number below. 
- It is described as S / N on the nameplate of the recorder. 
- It is displayed as serial number in "System " → "Version" in the recorder setting. 
[Operation] 

When you click the recorder selection button, the recorders from which data was imported into 
the PC are displayed as shown below. 
When detailed information (memo) edited in the recorder list has been added, the information is 
displayed in the format of "manufacturing number, detailed information (memo)." When the 
information has not been added, "manufacturing number," is displayed. (The comma is always 
displayed.) 
When you select a recorder, record data is displayed in the data list. 
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D) Recorder list 

The list of recorder imported to the PC is displayed. 
You can arbitrarily add detailed information (Memo) such as the installation location of the recorder 
to make it easy to identify recorders. This is convenient for example when operating multiple 
recorders. This detailed information(Memo) is printed as well. This is not a required setting item. 
Up to 24 one-byte characters can be entered for detailed information(Memo). 
 
[Operation] 

When you click the "Recorder list" button, the recorders from which data was imported into the 
PC are displayed as shown below. Enter detailed information in the memo field for each 
recorder and click the "OK" button to reflect information. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

E) Edit batch information 

Use this button to add batch information to imported record data. 
You can make it easy to identify record data by registering the test name and other information. Up 
to 64 one-byte characters can be entered. This detailed information is printed as well. 
 
[Operation] 

Click the "Edit" button to make batch information for each record data editable. 
When you complete editing the information, click the "Save" button to register the batch 
information. 
Not to register the information, click the "Cancel" button. 
For details about how to edit batch information, refer to Section 5.2.8, "Register and edit batch 
information of recorded data" 
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F) Display item 

This section describes how to display or hide items displayed in the data list. 
By default, all the items are displayed. The status set here is saved and the same display settings are 
used at the next software startup. 
 
[Operation] 

When you click the "Display item" button, the following window appears. 
Clear the check boxes for the items you want to hide and click the "OK" button. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

G) Filter 

This function can be used to filter record data displayed in the data list and display only necessary 
data. 
You can filter data with batch information, period, and sign status. The filter function is an AND 
filter using three items. 
 
[Operation] 

Enter each filter item and click the "Apply" button. 
To clear the edited filter, click the "Clear" button. In this case, clicking the "Apply" button 
displays all the data. 
Each filtering method is listed on the next page. 
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(1) Filtering data only with Batch 
Click the "Clear" button once. 
Edit the Batch filter only and click the "Apply" button. The Batch filter allows for AND 
search by inserting a space between character strings as with the web search engine. 

 
 
 
 
 
 
 
 

(2) Filtering data only with the Time 
Click the "Clear" button once. 
Edit the Time filter only and click the "Apply" button. 

 
 
 
 
 
 
 
 

(3) Filtering data only with the Sign status 
Click the "Clear" button once. 
Edit the Sign status filter only and click the "Apply" button. 

 
 
 
 
 
 
 
 

(4) Filtering data with Batch and Time 
Click the "Clear" button once. 
Edit Batch and Time filter and click the "Apply" button. 
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H) View 

This section describes the button used to display record data. You can check record data after login 
authentication. 
 
[Operation] 
Select record data you want to display and click the "View" button. The software does not operate 
even if you click the "View" button without selecting record data. For details about how to check 
record data, refer to Section 5.2.3, "Check and sign the recorded data" 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

I) Export 

Use this button to copy imported record data and signed record data to another folder. The export 
processing outputs all information such as recording data, recorder information, batch information 
etc. 
Use this button for example when migrating data or folders when purchasing a new PC or for other 
purpose. 
Use this button with the import function. 
 
[Operation] 
Click the "Export" button and select the destination folder to start exporting. 
For details about how to export data, refer to Section 5.2.9, "Migrate the signed record data to 
another PC" 
*Original data is not deleted. 
 

 

 

 

 

 

 

 

 

Export destination 

folder 
Reference source folder 

Copy 
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J) Import 

Use this button to copy data in the folder copied by the export operation to the import destination 
folder. 
Use this button for example when migrating data or folders when purchasing a new PC or for other 
purpose. 
 
[Operation] 
Click the "Import" button and select the original folder to start importing. 
For details about how to import data, refer to Section 5.2.9, "Migrate the signed record data to 
another PC".  
*Original data is not deleted. 
 

 

 

 

 

 

 

 

 

Import destination 

folder 

 

Exported folder 

Copy 
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5.3.3 Login authentication 
This section describes the screen for login authentication. 
Enter the user name and password and log in. 
 *- If login authentication fails ten times, the login authentication screen is forcibly closed. 
 - Both the user name and the password are case sensitive. 
 
The login authentication screen appears when you perform the following operations: 

- Displaying record data 
- Signing data 

 

 

 

 

 

 

 

 

 

 

You can select or type the user name. You can select how to specify the user name from View - 
Option settings on the menu. For details about Option settings, refer to Section "Option". 

 
- Selecting method 
When you click the arrow, selectable users are displayed. Select a login user. 

 
 
 
 
 
 
 
 
 

- Typing method 
Manually enter the login user name in the user name entry field. 
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5.3.4 Trend display 
This section describes the screen for displaying record data. 
For details about how to display the trend screen, refer to Section 5.2.3, "Check and sign the recorded 
data" 
For details about how to set up or operate the trend screen, refer to Chapter 6, " Ex.Sec Viewer 
-CONTROL-". 
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5.3.5 Signature 
This section describes the screen for signing data. 
One to three users can sign data. Sign 1, Sign 2, and Sign 3 do not have the concept of levels. 
Arbitrarily assign meanings to signatures and use them. You can employ the flexible signature 
operation. For example, the same account can be used to make Sign 1 and Sign 2 signatures. 
After signatures are made, they are applied to the [Sign] tab in Event Summary or "Sign 1," "Sign 2," 
and "Sign 3" in Extended security on the menu, for example. For details about how to sign data, refer 
to Section 5.2.3, "Check and sign the recorded data" 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

(1) Sign status 
Enter the evaluation of record data. 
Select Pass or Fail. 

(2) Comment 
Enter an arbitrary comment suitable for the signature. 
Up to 52 one-byte characters can be entered. 

 
 
- Sign status display in Event Summary 
The sign status display in Event Summary displays the sign status, user name, arbitrary text, date, 
and comment. 
Status    : Pass, Fail, or Not signed. 
User name : The name of the user who signed data. 
Note      : Arbitrary text you specified when registering the user in the recorder. 
Date      : date of signing data. 
Comment  : The text you entered in the comment field when signing data. 

(1) Sign status 

(2) Comment 
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- Permitting/prohibiting the signature by the user account 
If signature by the user account is prohibited, the following window appears and the user cannot 
sign data. 
To permit signature by the user account, you must set the permission by registering the user account 
in the recorder. You must set the permission before starting recording. For details about how to set 
the permission, refer to Section 4.2.5, "Permitting the electronic signature using the user account." 

 
 
 
 
 
 
 
 
- Examples of signatures 
Examples of signatures are shown below. 

 
Example 1 
Signs 1 to 3 are used by different accounts. 
 
 
 
 
 
 
 
Example 2 
Signs 1 and 2 are used by different accounts. Sign 3 is not used. 
 
 
 
 
 
 
 
Example 3 
Signs 1 and 2 are used by the same account and Sign 3 is used by another account. 
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5.3.6 Security log display 
This section describes the screen for checking audit trails. You can check and print the 
operation log of imported record data. 
For details about how to display data, refer to Section 5.2.4, "Check and print the audit trail 
(security log)".Security logs can be also printed. For details about printing, refer to Section 
6.3.3" Security log Print" 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
(1) Date 

Displays the date/time when the setting or operation is performed. 
(2) User name 

Displays the account name used to perform the setting or operation. 
(3) Log details 

Displays the log number and details of executed setup and operations. 
The log number is the number for each setting or operation log ([000] to [999]). 
For details about when each log is generated, refer to Appendix 2, "List of security logs". 

(4) Parameter display button 
The button is effective only when the parameter log file corresponding to the security log 
is saved. When the button is pushed, the support software "Parameter Loader" is activated 
and the contents of the target parameter are displayed. For parameter log file, refer to 
Section 4.5.4 "Parameter log file". 

(1) Date (2) User name (3) Log details (4) Parameter display button 
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5.3.7 Display and operation in each state of the recorded data 
This section describes the display and operation of Section 5.3.2 A) "Data list". 
 
Depending on the state of the recorded data, the background color of the data list display differs. 
Depending on each state, the next recording data acquisition, display and signature operation will 
differ. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
background 
color Description Action 

White Represents data that has 
been recorded. (*) 

At the next recording data import： 
→Recorded data is not updated. Signature information is also not cleared. 

Display： 
→Can display. If it can’t be displayed, there is a possibility that the data has been 

falsification. 
Signature： 

→Can sign. 
Green Represents data that 

recording is incomplete. 
At the next recording data import： 
→The recorded data is updated. When recording is completed, the background color turns 

white. 
Display： 

→Can display. If it can’t be displayed, there is a possibility that the data has been 
falsification. 

Signature： 
→Can sign. When signing, the following message will be displayed. 

After signing, the background color turns yellow. 
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background 
color Description Action 

Yellow Represents data that has 
signed data with 
incomplete recording. 

At the next recording data import： 
→Recorded data may be updated. When you update, the signature information is cleared. 

When updating, the following message will be displayed. 
 

 
 
 
Display： 

→Can display. If it can’t be displayed, there is a possibility that the data has been 
falsification. 

Signature： 
→Can sign. You can sign up to 3 people. 

Gray Represents data with 
falsification or 
corruption. 

At the next recording data import： 
→Recorded data is not updated. 

Display： 
→Can’t display. 

Signature： 
→Can’t sign. 

 (*) A file that has been completely recorded shows the following data 
1. The data that generated by recording stop operation (Power off operation during recording is also 
included.) 

2. The data that 
number 
of files 
under 
manag
ement 
reaches 
the 
upper 
limit 

Example 1：Record cycle；1 second、File rec cycle；1 hour 
  →The number of files under the management reaches the upper limit by a record for 50 hours. 

Example 2：Record cycle；1 second、File rec cycle；1 day 
  →The number of files under the management reaches the upper limit by a record for 50 days. 
 

[Note] 
If you sign a data with incomplete recording, the signature information is cleared the next time you 
import the file. It is recommended that you sign only data that have been recorded completely. 
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5.4 Menu 
The menu categories are File, View, Zoom, Event/Comment, Extended security, Language, Window, 
and Help. The menu list is shown below. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

- Instant view 

- Event summary 

- Touch scroll 

- Scale setting 

-Max./Min./Ave. 

- Toolbar 

- Option 

- Time Axis 

- Y Axis 

- Default Display 

 

Menu 

View 

Language 

- View Extended security data list 

- Save csv 

- Properties 

- Trend print 

- Trend print preview 

- Security log print 

- Security log print preview 

- Instant value print 

-Report print 

- Exit 

File Zoom 

- Japanese 

- English 

- About 

Help 

- Show/Hide Alarms 

- Show/Hide Messages 

- Show/Hide Comments 

- Find Previous 

- Find Next 

 

Window 

- Cascade window 

- Tile window Horizontally 

- Tile window Vertically 

- Select Active Window 

 

Event/Comment 

Extended security 

- Sign 1 

- Sign 2 

- Sign 3 

- Display Security Logs 
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5.4.1 File 
The File menu is used for file-related, printing, and other operations. 
 

Item Shortcut key Contents 

View Extended 
security data list - This is the home window for importing recorded data, confirming, signing, etc. 

Save csv - The data of the currently displayed trend display is output to the CSV file. 
(For details, refer to Section 6.4.1 "Save csv".) 

Properties Ctrl + Q Displays file information of the active trend window.  
(For details, refer to Section 6.4.2 "Properties ".) 

Trend print Ctrl + P Prints file information of the active trend window.  
(For details, refer to Section 6.3.1 C) "Trend print ".) 

Trend print preview - Perform the above print preview. 
(For details, refer to Section 6.3.1 A) "Trend print preview ".)  

Security log print - Print security log of recorded data currently being displayed.  
(For details, refer to Section 6.3.3 B) "Security log print".) 

Security log print 
preview - Perform the above print preview. 

(For details, refer to Section 6.3.3 A) "Security log print preview".)  

Instant value print - Print instant value of the recorded data currently being displayed. 
(For details, refer to Section 6.3.2 "Instant value print".) 

Report print - Print report of recorded data currently being displayed.  
(For details, refer to Section 6.3.4 "Report print".) 

Exit - End the Ex.Sec Viewer. 

 

5.4.2 View 
The View menu is used for display-related settings and operations and to display real-time trends. 
 

Item Shortcut key Contents 

Instant view Ctrl + I Shows or hides the instant value display area in the active trend window. 
If instant values are already displayed, the menu item is preceded by a check (). 

Event summary Ctrl + E Shows or hides the event summary area in the active trend window. 
If the event summary is already displayed, the menu item is preceded by a check (). 

Layout - 
Changes the layout positions of the trend display, instant value display, and event summary 
display areas in the active trend window. There are five layout patterns. 
(For details, refer to Section 6.2.1 B) "Changing Layout".)  

Touch scroll - 
Enables or disables the touch scroll function in the active trend window. 
If it is enabled, the menu item is preceded by a check (). 
(For details, refer to Section 6.2.1 C) " Touch scroll ".)  

Scale setting - Opens the Set Scale dialog. (For details, refer to Section 6.2.1 C) " Scale setting".)  

Max./Min./Ave. - Display Max. /Min. /Ave. of recorded data currently being displayed.  
(For details, refer to Section 6.2.4 " Max./Min./Ave.".) 

Toolbar Ctrl + Alt + T Shows or hides the toolbar. 
If it is displayed, the menu item is preceded by a check (). 

Option Ctrl + Alt + O Opens the Set Options dialog. (For details, refer to Section 6.5 " Option".)  

 



 5-45 

 

5.4.3 Zoom 
The Zoom menu is used for zoom-related operations. 
 

Item Shortcut key Contents 

Time Axis 

Dot by Dot：Ctrl + D 
Whole view：Ctrl + Z 

Point to point：Ctrl + T 
Manual zoom：Ctrl + N 

Selects a time-axis zoom type in the active trend window. 
The menu item corresponding to the selected zoom type is preceded by a check (). 
 (For details, refer to Section 6.2.2 A) "Time-axis Zoom".)  

Y Axis 

100%：F1 
125%：F2 
200%：F3 
400%：F4 

1000%：F5 

Selects a Y-axis zoom type in the active trend window. 
The menu item corresponding to the selected zoom type is preceded by a check ()  
(For details, refer to Section 6.2.2 B) "Y-axis Zoom".) 

Default Display Ctrl + R Resets the current zoom state in the active trend window to the default state. 
(For details, refer to Section 6.2.2 C) "Default display".)  

 

5.4.4 Event/Comment 
The Event/Comment menu is used for event or comment-related operations. 
 

Item Shortcut key Contents 

Show/Hide Alarms Ctrl + A Shows or hides alarm events in the trend display area in the active trend window. If they are 
displayed, the menu item is preceded by a check ().  

Show/Hide Messages Ctrl + M Shows or hides message events in the trend display area in the active trend window. If they are 
displayed, the menu item is preceded by a check (). 

Show/Hide Comments Ctrl + C Shows or hides comments in the trend display area in the active trend window. If they are 
displayed, the menu item is preceded by a check (). 

Find Previous Ctrl + “←” 
(left to cursor key) 

Searches the event/comment search results from the cursor position in the backward direction 
on the time axis for the nearest record and moves the cursor to that record. 

Find Next Ctrl + “→” 
(right to cursor key) 

Searches the event/comment search results from the cursor position in the forward direction  
on the time axis for the nearest record and moves the cursor to that record. 

 

5.4.5 Extended security 
Signatures and security logs are displayed. 
 

Item Shortcut key Contents 

Sign 1 - Makes the signature in Sign 1. After signing is completed, the sign status and signature 
date/time are displayed and Sign 1 becomes no longer available. 

Sign 2 - Makes the signature in Sign 2 After signing is completed, the sign status and signature 
date/time are displayed and Sign 2becomes no longer available. 

Sign 3 - Makes the signature in Sign 3 After signing is completed, the sign status and signature 
date/time are displayed and Sign 3becomes no longer available. 

Display Security Logs - Displays the security log. 
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5.4.6 Language 
The Language menu is used for language selection. 
 

Item Shortcut key Contents 

Japanese - Selects Japanese for display. 

English - Selects English for display. 

 

5.4.7 Window 
The Window menu is used to specify how to arrange windows and to select the active window. 
 

Item Shortcut key Contents 

Cascade window - Arranges open sub-windows so that they are obliquely cascaded. 

Tile window Horizontally - Arranges open sub-windows horizontally so that they are equally spaced. 

Tile window Vertically - Arranges open sub-windows vertically so that they are equally spaced. 

Select Active Window - 
All open sub-windows are registered with a menu here (*1). 
The selected sub-window will become the active window. 
The menu item corresponding to the active window is preceded by a check (). 

*1 This menu is not displayed if there is no open sub-window. 
 

5.4.8 Help 
The Help menu is used to display version information. 

 
Item Shortcut key Contents 

About - Displays information on the version of the Ex.Sec Viewer 
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5.5 Toolbar 
You can perform the same operations as when using some menus just by clicking the corresponding icon 
on the toolbar. The following actions can be executed. 
 

Icon Description Reference 
 
 
 
 

Displays the extended security data list. 
Section 5.3.2 
”Extended security data list 
display” 

 

Perform trend printing. Section 6.3.1 
 ”Trend print” 

 
 
 
 

Makes a signature. 
You can click these icons only while record data 
is displayed. 

Section 5.3.5 
 ” Signature” 

 
 
 
 

Displays the security log. 
You can click these icons only while record data 
is displayed. 

Section 5.3.6  
”Security log display” 

 
 
 
 

Displays the trend in the standard size in the dot 
unit. 

Section 6.2.2 A)  
”Time-axis Zoom” 

 
 
 
 

Displays the whole trend. 

 
 
 
 

Displays the trend between the specified start and 
end points. The range can be selected by dragging 
the graph display section with the mouse. 

 
 
 
 
 
 
 

Specify the zooming ratio by entering a 
numerical value that indicates the ratio of the X 
axis assuming that the Y axis is 1. 

 
 
 
 

Select the display ratio on the Y axis. You can 
select "100%," "125%," "200%," "400%," or 
"1000%” as the ratio. 

Section 6.2.2 B)  
”Y-axis Zoom” 

 
 
 
 

Displays/hides each event mark on the trend 
graph. 

Section 6.2.3 A)  
” Showing or Hiding Events” 

 
 
 
 
 

Searches for and moves to the event mark 
position. 

Section 6.2.3 B)  
” Event search” 

 
 
 
 
 

You can scroll the trend graph by dragging it 
with the mouse. 

Section 6.2.1 C)  
” Touch scroll” 
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6.Ex.Sec Viewer – CONTROL – 
 

6.1 Basic Layout of Trend Window 

6.1.1 Screen Layout 
The trend window layout is described below. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

(1) Title bar 
Shows the path of the open record trend file. It also includes buttons used to maximize, minimize, close, 
and otherwise operate the window. 

(2) Group selection tab 
Used to select the display group. 

(3) Trend area 
Graphically shows trend data. The trend area works in one of two modes: vertical trend and horizontal 
trend. 

(4) Instant value area 
Shows a list of instant trend data values. 

(5) Event summary area 
Shows a list of event data and comments included in the trend data. You can also perform search 
operation here. You can also check the signature here.  

(1) Title bar 

 

 

 

(2) Group selection tab 

 

 

 

(3) Trend area 

 

 

 

(4) Instant value area 

 

 

(5) Event summary area 

 

 



 6-2 

6.1.2 Trend area 
This area is roughly divided into three components: Scale area, Graph area, Cursor value area 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 (1) Scale area 
Shows scale plates. For details, refer to Section 6.1.2 A)"Scale area ". 

 (2) Graph area 
Graphically shows trend data. For details, refer to Section 6.1.2 B)"Graph area ". 

 (3) Cursor value area 
Shows measurement values at the cursor position as digital information. For details, refer to Section 
6.1.2 C)"Cursor Value Area". 

 (4) Common scale display area 
The common scale used by all the channels in a group is displayed. For details, refer to Section 6.1.2 
D) "Common scale display area ". 

(1) Scale area 
 
 
 

(3) Cursor value area 
 
 
 

(2) Graph area 
 
 
 

(4) Common scale display area 
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A) Scale area 

This area shows the scales of the channels registered with the display group. The rightmost 
scale works as the first scale, from which dividing lines are drawn. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 (1) Base channel change button 
When you click this button, the corresponding channel moves to the right (first scale 
position). When you place the cursor onto the button, the tag name of the corresponding 
channel pops up. 

 (2) Scale width 
Shows the scale width assigned to the channel. By double-clicking this display area, you can 
set the scale manually. (For details, refer to Section 6.2.1 D) "Scale setting") 

 (3) Unit 
Shows the unit assigned to the channel. 

 

(1) Base channel change button 
 
 
 

(2) Scale width 
 
 
 

(3) Unit 
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B) Graph area 

This area shows a graph of recorded trend data. Trend data is old on the left side and new on the 
right side. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

      

 

(1) Event display area 
Shows icons at the positions of alarms, messages, and comments. When you place the cursor at an 
icon, pertinent detail information will pop up. 
A : Red icon for an alarm that has occurred during recording or has been reset 
M : Green icon for a message that has occurred during recording 
C : Yellow icon for a comment 

(2) Common alarm display 
If a common alarm occurs, a pink line is drawn across the pertinent record area as shown in the 
above figure. 

(3) Cursor position indicator 
Shows a cyan  icon at the position of the currently selected record. Measurement values at the 
date and time corresponding to this position are displayed in the cursor value area described in 
Section 6.1.2 C) “Cursor Value Area”. 

(4) Graph display area 
Shows recorded trend data. You can move the cursor position by clicking the desired position in 
the graph display area. 

(5) Measurement time display area 
Shows the time the measurement was recorded. You can select a time format as described in 
Section 6.5 "Option". 

(6) Scroll bar 
If the desired trend data gets out of the screen due to time axis, Y axis, or other change, you can 
use the scroll bar to move the display position. 

(3) Cursor position indicator 

 

(1) Event display area (2) Common alarm display 

 

 

(5) Measurement time display area 

(4) Graph display area 

(6) Scroll bar 
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C) Cursor Value Area 

This area shows measurement values at the cursor position selected on the graph area. 
 
 
 
 
 
 

 
(1) Measurement time 

Shows the measurement time of the record data at the cursor position. You can select a time 
format as described in Section 6.5 "Option". 

(2) Digital display 
Shows digital values on all channels registered with the displayed group. Data on each channel 
consists of "scale and graph display state," "channel name," and "measurement values." 

 
Item Description 

Scale and 
Graph display 

state 
 

A click on this area toggles between three states of whether "scale" and/or "trend 
data" are shown or hidden as follows: 

☑: Both "trend data" and "scale" are shown. 
□: "scale" are hidden. 

Channel name Shows either “channel No.," "tag," or "description." 

Measurement 
values 

Shows measurement values as digital information. If the record type is 
"maximum/minimum," the display format is "[maximum]/[minimum]." 

(1) Measurement time 

 

 

(2) Digital display 
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D) Common scale display area 

This area shows common scales from the channel registered into display groups. The same scale is 
excepted. When "Enable Common scale display" option setting is enabled, it is displayed.  
In initialization, it is disabled. For details, refer to Section 6.5 "Option". 

*A scale is the same, and when units differ, it registers as another scale. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

(1) Scale width 
The scale width set as the channel is displayed. By double-clicking this display area, you can set 
the scale manually. (For details, refer to Section 6.2.1 D) "Scale setting") 
 

(2) Units 
Shows the unit assigned to the channel. 

(1) Scale width 
 
 
 

(2) Unit 
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6.1.3 Instant Value area 
This area shows a list of record data. One page displays up to 1000 records. 

 
 
 
 
  
 
 
 
 
 
 
 
 
 
 
 
 (1) Measurement value display 

This area shows record data on all channels registered with the displayed group. 
 

Item Description 

Time 

Measurement values are recorded at the cycle that is set on the recorder. The record 
cycle on the above figure is 100 milliseconds. 

(For information on record cycles, refer to the Operation Manual for the Paperless 
Recorder.) 

You can select a time format as described in Section 6.5 "Option". 

Measurement 
values 

Measurement values are displayed in columns, each corresponding to a channel. If the 
record type is "maximum/minimum," maximum and minimum values are displayed on 
separate columns unlike cursor values. The header contains the channel No., unit, and 
record type in that order. 

 
 (2) Page selection 

If recorded data exceeds 1000 records of instant values, you can select a page from a drop-down 
menu as shown in the above figure to display data that is currently invisible. 

 (3) Close button 
A click on this button hides the instant value display. To show it again, select “Instant Values” 
from the View menu. 
(For details, refer to Section 6.2.1 A) "Display Selection"). 

(2) Page selection 

 

 

 

(1) Measurement value display 

 

 

(3) Close button 
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6.1.4 Event Summary area 
Detailed display of event information, display of comment information, confirmation of signature 
information. 

 

 

 

 

 

 

 

 

 

 

 

 

 (1) Display selection tab 
Different tabs correspond to different types of information displayed on them. 

 (2) Detailed event information display 
This area displays a list of detailed event information that differs among the tabs. The information 
items displayed on each tab are as follows: 

 
Tab Description 項目 

Alarm Displays information on alarm events that have 
occurred during recording. 

Time When the event occurred 
Channel  1 to 48 
Alarm level 1 to 4 
Occurrence/Recovery Occurrence or Recovery 

Message 
Displays message and system message events that 

have been occurred during recording. 
 

Time When the event occurred 

Event type  Message or system 
message 

Message Message 

All Displays both alarm and message events. 

Time When the event occurred 

Event type  Alarm, message, or 
system message 

Event status Detailed status 

Comment Displays comments.  
Time When the comment was 

entered 

Comment Comment text 

Sign Display signature information. 
For signature, refer to Section 5.3.5 "Signature." 

Status Not signed、Pass、Fail 
User name signer 

Note Set at user registration on 
recorder 

Date Signing date 
Comment Enter at signature 

 

(3) Close button 
A click on this button hides the event summary display. To show it again, select “Event Summary” 
from the View menu. (For details, refer to Section 6.2.1 A) "Display Selection.") 

(1) Display selection tab 

 

 

 

(2) Detailed event information display 

 

 

 

3) Close button 

 

 

 



 6-9 

 

6.2 Operate the trend screen 

6.2.1 View 
A) Display Selection 

- Instant Values area 
You can specify whether to show or hide the Instant Values area. 
You can change this setting on the “View” menu or by using the short-cut key "Ctrl+I." 

 
- Event Summary area 

You can specify whether to show or hide the Event Summary area. 
You can change this setting on the “View” menu or by using the short-cut key "Ctrl+E." 

 

B) Changing Layout 

Change Layout allows you to change the layout of the graph display area, instant value display 
area, and event summary display area by selecting one of the following five patterns from the 
“View” menu or Toolbar. 

 

- Layout 1            - Layout 2           - Layout 3 
 

 

 

 

 

 

- Layout 4          - Layout 5 
 

 

 

 

 

 

C) Touch scroll 

The trend graph can be scrolled by mouse dragging. If the Touch Scroll function is set to "ON," 
the mouse cursor shape on the trend graph is as shown in Lower figure (left) and is changed 
during mouse dragging as shown in Lower figure (right). You can change this setting on the 
“View” menu or Toolbar. 

 

 

 

Graph 

Instant values 

 
Event summary 

 

Graph 

Instant values 

 

Event 

summary 

 

Graph Instant 

values 

 

Event 

summary 

 

Graph 

Event summary 

Instant values Instant values 

 

Instant values Event summary 
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D) Scale setting 

You can freely change the scale width of channels registered with the group that is displayed 
in the trend window. When you double-click “Scale width” in the scale display area, the Set 
Scale dialog shown in below. This dialog can also be opened from the “View” menu or using 
the short-cut key "Ctrl+Alt+O." 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

(1) Group name 
The name of the display group being edited. 

(2) Tag display selection 
You can select "CH No." or "TAG" as the edit item name displayed. 

(3) Edit items 
Edit scale settings by selecting values from combo boxes or directly entering values from 
the keyboard. 

 

Item Selectable values/input 
range Decimal point Description 

Auto/Manual Auto or Manual - 
To make the settings edited here effective, you need to select 
"Manual." When "Auto" is selected, the original scale settings 
will be assumed as is. 

Scale Range (L) Standard: -32000 to 32000 As per the 
setting Enter the minimum value of the scale range. 

Scale Range (H) Same as the above Same as the 
above Enter the maximum value of the scale range.  

 

(1) Group name 

 

 

 

(2) Tag display 

 

 

 

 

(3) Edit items 
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6.2.2 Zoom 
A) Time-axis Zoom 

- Dot by dot: The trend data is displayed in dot-by-dot fashion, meaning that the standard size is kept. 
- Whole view: The trend data is displayed in full. 
- Point to point: The trends between the specified start and end points are displayed. 

The range can be determined by mouse-dragging on the graph display area. Specify 
the start point by clicking on it, drag the mouse to select the range, and release the 
mouse button at the desired end point. The range selected is displayed in cyan as 
shown in the figure below. (If you release the mouse button at a point of time earlier 
than the start point, that point is treated as the start point and the specified start point is 
treated as the end point.) 

 
 

 

 

 

 

 

 

 

 

 

 

 

- Arbitrary: You can set the magnification by entering a value representing the percentage of the X axis 
to the Y axis on the assumption that the Y axis is 1. Use the Toolbar for this setting. 

 

 

 

 

 

 

(1) Zoom-in button 
Each time you click this button, the time axis is zoomed in by one step. 

(2) Zoom-out button 
Each time you click this button, the time axis is zoomed out by one step. 

(3) Magnification input area 
You can view or enter the magnification. A value of "1.0" represents the magnification for 
the Dot by Dot display. The first decimal place of your specified value is regarded as 
enable. The input range is from "0.1" to "the magnification for the full display." 

(1) Zoom-in button 
 
 
 

(3) Magnification input area 
 
 

(2) Zoom-out button 
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B) Y-axis Zoom 

Select the Y-axis display magnification. Selectable values are "100%," "125%," "200%," 
"400%," and "1000%."  

 

C) Default Display 

This item resets the zoom settings to their initial values. 
The time-axis zoom mode is reset to "Dot by Dot" and the Y-axis zoom mode is reset to "100%." 
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6.2.3 Event/Comment 
A) Showing or Hiding Events 

You can specify whether to show or hide each event mark on the trend graph. 
For this purpose, use the Event/Comment Menu, Toolbar, or the appropriate short-cut key. 
Events are classified into the types indicated below. You can specify whether to show or hide each 
event type 

 

Event type Alarm Message Comment 
Short-cut key Ctrl + A Ctrl + M Ctrl + C 

 

 

B) Event search 

You can search for an event mark position and move to that mark. You can only search for events 
that are currently "Shown" as specified by "Show/Hide Events" described in Section 6.2.3 A) 
"Showing or Hiding Events" events will be skipped during search. 
- Find Previous: Moves to the event mark that is previous to the selected position in the trend display 
area. 
- Find Next: Moves to the event mark that is next to the selected position in the trend display area. 
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6.2.4 Max./Min./Ave. (It supports since Ver.2.10) 
 

 

 

 

 

 

 

 

A) Setting 

It is a function to calculate the maximum value, minimum value, and average value of the recording data currently 

displayed. By setting display items, channels, and periods, it is a function that calculates the value of the 

selected ”Max./Min./Ave.”, displays it, and prints it. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Caution  
If the record type of the channel recorded by the main unit is "Max / Min", it is calculated as follows. 

Max.: Calculated based on the "Max" data of the specified period. 

Min.: Calculated based on the "Min" data of the specified period. 

Ave.: Calculated as ("Max" + "Min") / 2 of the specified period. 
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Item Setting value  
/ input range Description 

Max./Min./Ave. Max. Min. Ave. Set the items to be calculated. For calculation method, please refer to “● 
Calculation method” below. 

Display group ― Display group name currently being edited. 

Channel selection CH Select the CH to calculate. 

Period Range specification 

Select the range for outputting data. 
 -All data: All data from the recording start to the recording stop is used. 
 -Display range: Use the data of the range currently displayed on the trend 

window 
 -Range Specification: Use data of specified time range. 

Print 

Front page 
ON/OFF of the page 

No. 
Graph title 

●Front page 
Set the items to be printed at the same time as printing. 
 -Front page: This page shows channel information etc. 
 -Trend: This page shows the trend for the specified period. 

●ON/OFF of the page No. 
Specify whether to print page numbers. 

●Graph title 
 Enter the graph title. 

 

 

●Calculation method 
The calculation method of each value is shown below. 

Max./Min./Ave. Description 
Max. The maximum value is calculated by referring to each sampling. 

In addition, when there are multiple values that are the maximum value, the time of the oldest 
recording point is adopted. 

Min. The minimum value is calculated by referring to each sampling. 
In addition, when there are multiple values that are the minimum value, the time of the oldest 
recording point is adopted. 

Ave. The average value uses each sampling to calculate the average value. 
The following values are not included in the calculation. 
-H-: Upper limit value swing 
-L-: Lower limit value swing 
B. OUT: Burnout 
INVALID: Exception operation processing (division by 0, etc.) 
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B) Display 

Click “OK” button in section 6.2.4 A) “ Setting ” and the following calculation results will be displayed. 

If you want to change settings , click the "Back" button. 

If printing is required, it is recommended to print after confirming the print screen in "Print preview". 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

(1) Prinet preview 

Display the calculated results and a print preview of the front page, trend, etc. 

(2) Print 

Prints the displayed calculation results and the front page, trend, etc. 

(3) Back 

Return to 6.2.4 A) “ Setting ” settings and reset. 

(4) OK 

Close Max./Min./Ave. 

 (1)Print preview 

  (2) Print  

 

 (3) Back  

 
 (4) OK  
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C) Print preview 

Click the "Print Preview" button in Section 6.2.4 B)" Display" to display the print preview screen. 

As the print contents, the calculation result in Section 6.2.4 B)"Display" + Print item set in Section 6.2.4 A)" Setting" 

will be printed. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

(1) Print button 

Starts printing.  

(2) Margin button 

Allows you to set margins. A click on this button opens the Page Setup dialog shown below 

You cannot change the paper type or print orientation. Please change from the printer setting in 6.3.2 A) 

"instant value print setting". 

* You can adjust the print image by setting the margin. 

 

 

 

 

 

 

 

 

 

 

 

(1)Print button 

 

 

 

(2)Margin button 

 

 

 

(3) Zoom mode selection 

 

 

 

(5)Page selection  

 

 

 

(4) Print image 

 

 

 
(6) Header1 

 

 

 

(7) Header 2 

 

 

 

(8) Footer 

 

 

 

(9) Data range 
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(3) Zoom mode selection 
Select the print image magnification. You can select one of the following values: 
"Auto," "50%," "75%," "100%," "125%," "150%," "200%," and "300%" 

(4) Print image 
Shows the print image. 

(5) Page selection 
Use the up and down buttons to turn pages, by one page at a time. 

(6) Header1 
Record management file name and group name are displayed. 
Also, if you enter "Graph title" in "Options", the graph title will be displayed at the top 
of the record management file name. For options, refer to Section 6.2.4 A)" Setting". 

(7) Header2 
Recorder information, recorder version ([Main], [AI]), Ex.Sec Viewer version, printing 
date and time are displayed. 

(8) Footer 
Signature information is displayed. 

(9) Data range 

It is the data range calculated and set in Section 6.2.4 A)" Setting". 

 

 

● Front page  
Print calculation target channels information. 

It is printed on the first page only when "Front page" is selected in "Print" of Section 6.2.4 A) "Setting ". 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

(1) CH infomation 

Information on the channel set in "Select CH" of "Section 6.2.4 A) "Setting "is displayed. 

The channel number, unit, TAGNo., and display color are displayed.

(1) CH infomation 
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●Trend 
Consolidate and print the specified range of trend data on one page. 

It is printed on the first page or the second page only when "Trend" is selected in "Print" of Section 6.2.4 A) " Setting ". 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

*If there are many channels as shown above, set the following to reduce the number of channels displayed. 

・ Use the common scale display function. (Recommendation) 

>Using “common scale display” in Section 6.5 “Option”, “unit” and “scale” display the scale as one scale. 

• Hide the displayed channel scale. 

> Set "Display state of scale and graph" in Section 6.1.2 C) "Cursor Value Area" to" Hide ". 

 

●Calculated data 
The data displayed in Section 6.2.4 A) "Setting" s printed. 

This page is always printed regardless of the settings. 
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6.3 Print function 

6.3.1 Trend print 
A) Print preview 

The print preview of the current trend windows is displayed. This window can perform the image 
check before printing. 
A preview window is displayed by [File] > [Trend print preview]. 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

(1) Print button 
Starts printing. For further information, see Section 6.3.1 C)  "Print" 

(2) Print Options button 
Allows you to set the print options. For further information, see Section 6.3.1 B) "Print Options" 
 

 

(1) Print button 

 

 

 

(2) Print Options button 

 (3) Margin button 

 

 

 

(4) Zoom mode selection 

 

 

 

(6) Page selection 

 

 

 

(5) Print image 

 

 

 

(7) Header1 

 

 

 

(8) Header2 

 

 

 

(9) Footer 
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(3) Margin button 

Allows you to set margins. A click on this button opens the Page Setup dialog shown below 
You cannot change the paper type or print orientation. Please change from the printer setting 
in 6.3.2 A) "instant value print setting". 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

(4) Zoom mode selection 
Select the print image magnification. You can select one of the following values: 
"Auto," "50%," "75%," "100%," "125%," "150%," "200%," and "300%" 

(5) Print image 
Shows the print image. 

(6) Page selection 
Use the up and down buttons to turn pages, by one page at a time. 

(7) Header1 
Record management file name and group name are displayed. 
Also, if you enter "Graph title" in "Options", the graph title will be displayed at the top of the 
record management file name. For options, refer to Section 6.3.1 B) "Print Options". 

(8) Header2 
Recorder information, recorder version ([Main], [AI]), Ex.Sec Viewer version, printing date 
and time are displayed. 

(9) Footer 
Signature information is displayed. 
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B) Print Options 

You can use Options to configure "Print" settings.  

The setting dialog opens a print option by selecting an "Options" from a Preview window. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

Items Setting value/input 
range Description 

Print Type Page unit, 
Display range, 

Specify the range of record data to be printed. 
Pages: All the record data that, included in the specified display span, extends 

 over multiple pages will be printed. 
Display range: Only a single page of the record data displayed in the 

 Trend window will be printed. 
ON/OFF of the 
page No. ON, OFF Specify whether to print page numbers. 

ON/OFF of the 
guide(Subscript 
printing) 

ON, OFF Specify whether to print the suffix for each channel at the graph end point. 

Graph title 
No restriction on 
the number of 
characters 

Enter the graph title. 

X-axis 
No restriction on 
the number of 
characters 

Enter the X-axis title. 

Y-axis 
No restriction on 
the number of 
characters 

Enter the Y-axis title. 

Event display ON, OFF Specify whether to print each event mark. 

Event position Inside trend 
Outside trend 

Select the position where the detailed event description will be printed. 
Within trend: The description will be printed within the trend graph. 
Out of trend: The description will be printed out of the trend graph. 

Font size 6 - 12 Select the font size for the detailed event description. 
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C) Print 

You can print the currently displayed Trend window content. 
For this purpose, use the [File] > [Trend print], or the short-cut key "Ctrl+P." 
When you select [Trend Print], the Print dialog shown below opens. 
After setting options, click the Print button. Printing starts. 
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6.3.2 Instant value print 
A) instant value print setting 

When you click the "instant value print" button, the instant value print setting window is displayed. 
Instant value printing is possible by instant value printing setting. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Items Setting value/input 
range Description 

Printer Select Select the printer to use. 

Printer settings ― Set the printing direction, paper size, etc. 
The setting items differ depending on the type of printer selected in "Printer". 

Print group ― 

Display the recording group to be printed. 
Recording groups can be selected on the "Group section tab" on the trend 
display. 
For the group selection tab, see Section 6.1.1 "Screen Layout". 

ON/OFF of the 
page No. ON, OFF Specify whether to print page numbers. 

Graph title 
No restriction on 
the number of 
characters 

Enter the graph title. 

Print information ― Displays the printing direction and paper size information set in "Printer 
Setting". 

Print area All Data/Select time Specify the range of printing. 

Record type ― 
The recording type of each channel is displayed. Depending on the recording type, 
the number of print columns is different. 
Inst：1 column Ave：1 column M/M：2 columns 

Number of print 
columns per page 1 - 24 

Sets the number of columns to be printed on one page. 
Up to 24 columns (Portrait and Landscape) can be set. 
By increasing the number of columns, you can reduce the number of prints. 
You can’t specify beyond the number of columns used in the display group. 
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Items Setting value/input 
range Description 

Number of prints ― Displays the number of prints in the current print setting. 

Print preview ― Displays print preview in the current print setting. 

Margin ― Set the margins. 
You can’t change the font, paper, or orientation. Please set in printer setting. 

Apply ― 

Apply and save the current instant value print setting. 
The following items are not saved. 
· Graph title 
· Number of print columns per page 

Cancel ― Cancel the set print settings and close the setting window. 

Print ― 

Execute printing. 
When clicking, the final confirmation window will be displayed. If there is no 
problem, please click "Yes" and execute printing. 
* We recommend that you print after checking the print format in print preview. 

 

B) Print preview 

The print preview of the instant value is displayed. This window can perform the image check 
before printing. A preview window is displayed by "Print Preview" button in Section 6.3.2 A) 
"instant value print setting". 

 
(1) Print button 

 

 

 

(2) Margin button 

 

 

 

(3) Zoom mode selection 

 

 

 

(5) Page selection 

 

 

 

(4) Print image 

 

 

 

(6) Header1 

 

 

 

(7) Header2 

 

 

 

(8) Footer 
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(1) Print button 
Starts printing. For further information, see Section 6.3.2 C) "Print" 

(2) Margin button 
Allows you to set margins. A click on this button opens the Page Setup dialog shown 
below 
You cannot change the paper type or print orientation. Please change from the printer 
setting in 6.3.2 A) "instant value print setting". 
* You can adjust the print image by setting the margin. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

(3) Zoom mode selection 
Select the print image magnification. You can select one of the following values: 
"Auto," "50%," "75%," "100%," "125%," "150%," "200%," and "300%" 

(4) Print image 
Shows the print image. 

(5) Page selection 
Use the up and down buttons to turn pages, by one page at a time. 

(6) Header1 
Record management file name and group name are displayed. 
Also, if you enter "Graph title" in "Options", the graph title will be displayed at the top 
of the record management file name. For options, refer to Section 6.3.2 A) "Instant value 
print". 

(7) Header2 
Recorder information, recorder version ([Main], [AI]), Ex.Sec Viewer version, printing 
date and time are displayed. 

(8) Footer 
Signature information is displayed. 
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C) Print 

Execute printing. 
Printing is executed with the "Print" button in "instant value print setting" in Section 6.3.2 A). The 
following window will be displayed. If there is no problem with the printing direction, paper size, 
print area, number of prints etc, please click "Yes" and execute printing.  

*It is displayed in Ver. 2.10 or later. 
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6.3.3 Security log print 
A) Print preview 

The print preview of the security log is displayed. This window can perform the image check 
before printing. A preview window is displayed by [File] > [Security log print preview]. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

(1) Print button 
Starts printing. For further information, see Section6.3.3 B) "Print" 

(1) Print button 

 

 

 

(2) Margin button 

 

 

 

(3) Zoom mode selection 

 

 

 

(5) Page selection 

 

 

 

(4) Print image 

 

 

 
(6) Header1 

 

 

 

(7) Header2 
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(2) Margin button 
Allows you to set margins. A click on this button opens the Page Setup dialog shown below 
You cannot change the paper type or print orientation. Please change from the printer setting 
in 6.3.2 A) "instant value print setting". 
* You can adjust the print image by setting the margin. 

 

 

 

 

 

 

 

 

 

(3) Zoom mode selection 
Select the print image magnification. You can select one of the following values: 
"Auto," "50%," "75%," "100%," "125%," "150%," "200%," and "300%" 

(4) Print image 
Shows the print image. 

(5) Page selection 
Use the up and down buttons to turn pages, by one page at a time. 

(6) Header1 
Record management file name and group name are displayed. 
Also, if you enter "Graph title" in "Options", the graph title will be displayed at the top 
of the record management file name.  

(7) Header2 
Recorder information, recorder version ([Main], [AI]), Ex.Sec Viewer version, printing 
date and time are displayed. 

 

B) Print 

Print the security log. 
For this purpose, use the [File] > [Security log print]. 
When you select [Security log print], the Print dialog shown below opens. 
After setting options, click the Print button. Printing starts. 
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6.3.4 Report print (It supports since Ver.2.10) 
A) Report print setting 

Click the "Print Report" button to display the report print setting window. 

It is a function to print daily and monthly reports. It is possible to create a report by selecting the items you want to 

output from among "Max / Min", "Average", and "Instant value". 

 

 

 

 

 

 

 

 

 

 

 Caution  
-Please note that the channel recorded with " Max / Min " (Record type) can not be output as a report. 
-Depending on the recording cycle and file recording cycle settings, it may take approximately 5 

minutes to display the preview. 
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Item Setting value  
/ input range Description 

Printer Select Select the printer to use. 

Printer settings ― Set the printing direction, paper size, etc. 
The setting items differ depending on the type of printer selected in "Printer". 

Print group ― 

Display the recording group to be printed. 
Recording groups can be selected on the "Group section tab" on the trend 
display. 
For the group selection tab, see Section 6.1.1 "Screen Layout". 

ON/OFF of the 
page No. ON, OFF Specify whether to print page numbers. 

Graph title 
No restriction on 
the number of 
characters 

Enter the graph title. 

Print information ― Displays the printing direction and paper size information set in "Printer 
Setting". 

Display item ― 

Select the data you want to calculate from "Max. / Min.", "Ave.", and "Inst.". 
Details of each item are shown below. 
● Daily report 

Max. / Min.: Calculates the maximum and minimum of each hour  
(Example  00:00:00 to 00:59:99). 

Ave.: Calculate the average value of each hour 
 (Example  00:00:00 to 00:59:99). 

-H-, -L-, B OUT, INVALID are excluded from the calculation. 
Inst.: A value at every hour (Example, 00:00:00). If there is no data, leave 

blank. 
 
● Monthly report 

Max. / Min.: Calculate the maximum and minimum values from 00:00:00 to 
23:59:99 each day. 

Ave.: Calculate the average value from 00:00:00 to 23:59:99 each day. 
-H-, -L-, B OUT, INVALID values are excluded from the 
calculation. 

Inst.: The value of 00:00:00 each day. If there is no data, leave blank. 

Dairy report All data / Select time 
Set when printing daily reports. It is also possible to set the start date and end 
date as the period you want to output, and print the daily report of the specified 
period. 

Monthly report 
(Data range) All data / Select time 

Set when printing monthly reports. It is also possible to set the start date and end 
date as the period you want to output, and print the monthly report of the 
specified period. 

Monthly report 
(First  row) 

1st of the month  
/ Start day 

Select the first line of the monthly report from "1st of the month "and "Start day". 
1st of the month: Create a monthly report from the first day of every month. 
Start day: Creates a monthly report with the start date set as the recording start 

date or range specification as the first line. 
 
The details of "1st of the month " and " Start day" are shown below. 
Example: Recording period; 2019/01/05 to 2019/02/10 
 
● 1st of the month 
・ When the data range is "All data"; 
2019/01 / 01-2019 / 01/31, 2019/02 / 01-2019 / 02/28 
Monthly reports for two months of are created. 
・ When the data range is set as "Range designation", "2019/01/07-2019/02/06"; 
2019/01 / 01-2019 / 01/31, 2019/02 / 01-2019 / 02/28.Monthly reports for two 
months of are created. 
 
● Start date 
・ When the data range is "All data"; 
2019/01 / 05-2019 / 02/04, 2019/02 / 05-2019 / 03/04 
Monthly reports for two months of are created. 
・ When the data range is set as "Range designation", "2019/01/07-2019/02/06"; 
2019/01 / 07-2019 / 02/06. A monthly report for one month of is created. 
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B) Print preview 

The print preview of the Report print is displayed. This window can perform the image check 
before printing. 

 The print preview window is displayed by the "Print preview" button in Section 6.3.4 A) "Report 

print setting".。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

(1) Print button 

 

 

 

(2) Margin button (3) Zoom mode selection 

 

 

 

(5)Page selection 
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(1) Print button 
Starts printing.  

(2) Margin button 
Allows you to set margins. A click on this button opens the Page Setup dialog shown 
below 
You cannot change the paper type or print orientation. Please change from the printer 
setting in 6.3.4 A) "Report print settinginstant value print setting". 
* You can adjust the print image by setting the margin. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

(3) Zoom mode selection 
Select the print image magnification. You can select one of the following values: 
"Auto," "50%," "75%," "100%," "125%," "150%," "200%," and "300%" 

(4) Print image 
Shows the print image. 

(5) Page selection 
Use the up and down buttons to turn pages, by one page at a time. 

(6) Header1 
Record management file name and group name are displayed. 
Also, if you enter "Graph title" in "Options", the graph title will be displayed at the top 
of the record management file name. For options, refer to Section  6.3.4 A) "Report 
print setting". 

(7) Header2 
Recorder information, recorder version ([Main], [AI]), Ex.Sec Viewer version, printing 
date and time are displayed. 

(8) Footer 
Signature information is displayed. 

(9) Data range 
Displays the currently displayed daily or monthly report period. 

(10) CH information 
The information of the recorded channel is displayed. 
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6.4 File-related Operation 
6.4.1 Converting to CSV 

The record data can be converted to CSV file format. When you select “Save CSV” from the 
“File” menu, the Convert to CSV dialog shown in below opens. 
You can look up CSV files using Excel (*) and other applications. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

(1) Data output range 
Select the range of data to be output. 
- All data: All data from recording start to recording stop will be output. 
- Range specification: Data in a specified range of time will be output. (The initial data output 

range is "All data.") 
 

(2) Add header information 
Specify whether to add header information, including channel and group information, to the 
CSV files. 

 
When you click the “OK” button, a dialog opens, prompting you to select the save-to folder. 
When you select the save-to folder, the following three CSV files are created: 

● ***dmt.csv file：Main trend file 
● ***dst.csv file：Sub trend file 
● ***dms.csv file：Signature information file（Main record） 
● ***dss.csv file：Signature information file（Sub record） 
● ***dme.csv file：Event file 

*For the CSV file output image, refer to Appendix 3"Record Format (ASCII)." 
 

(1) Data output range 

 

 

 

(2) Add header information 
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6.4.2 Properties 
The Properties dialog displays file information. The following items are displayed: 
"File path," "Serial number," Software version (of the recorder)," "(Measurement) start time," 
"(Measurement) end time," "Number of records," and "Record cycle." 
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6.5 Option 
You can use Options to configure "View" settings. 
After setting changes are completed, click the “OK” button to save the settings. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Item Setting value/input range Description 

Background color All colors Set the background color of “real-time trend window” and “trend window”.(*1) 

Grid All colors Set the cell border color on “real-time trend window” and “trend window”.(*1) 

Time format 

yyyy/mm/dd hh:mm:ss 
dd/mm/yyyy hh:mm:ss 
dd-mmm-yy hh:mm:ss 
mmm-dd-yy hh:mm:ss 

Set the time format on the entire Data Viewer, including the format for record 
data measurement times. (*2) 

Save destination 
folder Folder reference Select the folder where you want to import recorded data. 

User description 
upon authenticaton 

Selection expression/ 
Descriptive expression 

Select the method of describing the username at login and signature. 
Selection expression  ：It is a method of selecting from the user name set on the 

recorder and entering it. 
Descriptive expression：It is a method of entering a user name with a keyboard. 

Common scale 
display 

Enable common scale 
display 

When a measurement file is opened, a common scale display is enabled. 
The common scale display is a function to display it as a common scale if "Unit" 
and "Scale" are the same. 

*1 Select any color from the Select Color dialog, and preview the results by looking at the graph image 
  displayed on the preview area. 
*2 Time format examples (representing 13:00:00 on April 1, 2012) 

yyyy/mm/dd hh:mm:ss → 2012/04/01 13:00:00 
dd/mm/yyyy hh:mm:ss → 01/04/2012 13:00:00 
dd-mmm-yy hh:mm:ss → 01-Apr-12 13:00:00 
mmm-dd-yy hh:mm:ss → Apr-01-12 13:00:00 
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7.Troubleshooting 
 

No. Problem Action 

1 Ex.Sec Viewer can’t start up. Please insert the authentication key in PC and start it. 

2 I forgot the login password for the 
administrator account. 

Recorder:  
- If only one administrator account is registered 
→ Contact your dealer or our sales staff. 

- If two or more administrator accounts are registered 
  → Refer to Section 4.2.10, "Resetting the password (if you forget the 

password)." 
Ex.Sec Viewer :  

Contact your dealer or our sales staff. 

3 I forgot the login password for the user account. 
Recorder: Refer to Section 4.2.10, "Resetting the password (if you forget 

the password)." 
Ex.Sec Viewer : Contact your dealer or our sales staff. 

4 The authentication-key does not operate. 
Contact your dealer or our sales staff. 
For details about the authentication-key, refer to Section 5.1.6, "About the 
authentication-key." 

5 I lost my authentication-key. Contact your dealer or our sales staff. 

6 There is no data for extended security. 
The extended security function could not be enabled. 
Refer to Section 4.2.1, "Enabling the extended security function." 

7 Recorded data can’t be imported. 
The extended security function could not be enabled. 
Refer to Section 4.2.1, "Enabling the extended security function." 

8 I mistook the input of signature information. It can’t be canceled after signature. Please sign carefully. 

9 I want to change items permitted for the user 
account. 

If you log in using the administrator account, you can edit the relevant 
account again. 
Configure settings according to Section 4.3.1, "Registering a user." 

10 I want to use the parameters set on Parameter 
Loader. 

Save the parameters in the following file path in the SD card and load the 
parameters from "System " -> "SD / Param" -> "Param save" and use. 
Parameter storage destination: "SD / Recorder / Prm" 

11 (Use the Parameter Loader) 
Parameter can’t be changed via network. 

If the security mode is extended security, you can’t change parameters via 
the network. Save the parameters in the following file path in the SD card 
and load the parameters from "System " -> "SD / Param" -> "Param save" 
and use. 
Parameter storage destination: "SD / Recorder / Prm" 

12 Real-time trend of Data Viewer can’t be used. 
When security mode is extended security, real time trend can not be used. 
Please import the file to Ex.Sec Viewer and check the recorded data. 

13 Recording can’t be started with DI. 
When the security mode is extended security, recording can not be started / 
stopped by DI input. In order to start / stop recording with DI input, it is 
necessary to turn off security mode. 

14 Recording stopped automatically. 

When the security mode is extended security, the overwrite function is 
turned off. Therefore, when the remaining capacity of the internal memory 
and SD card runs out, recording may stop. We recommend the following 
action. 
- Insert the SD card and record it. 
- Periodically check the remaining capacity of the inserted SD card. in the 

recorder. 
It is also possible to perform DO output with the function of "Int. SP DO" 
when the remaining capacity of the SD card becomes 10% or less .(For 
details, refer to the main unit instruction manual.) 
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No. Problem Action 

15 Recording is not stopped, but the recording 
file is divided. 

When the power is turned off during recording, the recording file will be 
split.It may occur at power failure. 
Since it is impossible to combine recording files, please confirm, sign, etc 
for each recording file. 

16 I failed to log in 10 consecutive times and the 
account was locked. 

You will not be able to log in for 24 hours when your account is locked. In 
order to use the account again, it is necessary to log in again after 24 hours, 
log in as an administrator user, and clear the password. 
For details on clearing passwords, refer to Section 4.2.10 " Resetting the 
password (In the case of password forgot)". 

17 
Trend print, security log print ,Max. / Min. 
/ Ave. print direction, paper size can not 
be changed. 

The print direction and paper size settings can be changed from 
"Printer settings" under "Instant value print" and "Report print". 

18 Report can not be output. 

This is because you have set the recording type to “Max / Min” and 
recorded data. . 
We are sorry, but with this function, it is not possible to create a 
report from the recorded data of the record type “Max / Min”. 
Set the recording type to "Average" or "instant value" on the main 
unit, and then record. 

19 The trend is not displayed cleanly in the 
"Max./ Min./ Ave." function. 

Please try the following. 
-Use "Common scale display" in the display menu to reduce the 

number of displayed scales. 
-Adjust the data output range. 
- Adjust the margin. 

20 Report print preview window is not 
displayed. 

When the number of data is large, it may take about 5 minutes to 
display. 
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Appendix 
Appendix‐1 Selection List of Permitted Items 

The list of operation items that can be permitted for the user account is shown below. 
The major item indicates each key in the permitted operation items. The minor items indicate an operation item in 
the major items. 
The relevant setting item indicates a key or operation for a minor item. 

No. Major item Sub item Key,Operation 

1 

Parameter 

Input Parameter‐Input CH‐Input 

2 Scaling Parameter‐Input CH‐Scaling 

3 Display(Input) Parameter‐Input CH‐Display 

4 Scale(Input) Parameter‐Input CH‐Scale 

5 Alarm value(Input) Parameter‐Input CH‐Alarm value 

6 Alarm action(Input) Parameter‐Input CH‐Alarm action 

7 REC/CALC(Input) Parameter‐Input CH‐REC/CALC 

8 Copy(Input) Parameter‐Input CH‐Copy 

9 F value Parameter‐Calc.CH‐F value 

10 Timer Parameter‐Calc.CH‐Timer 

11 Display(Calc) Parameter‐Calc.CH‐Display 

12 Scale(Calc) Parameter‐Calc.CH‐Scale 

13 Alarm value(Calc) Parameter‐Calc.CH‐Alarm value 

14 Alarm action(Calc) Parameter‐Calc.CH‐Alarm action 

15 REC/CALC(Calc) Parameter‐Calc.CH‐REC/CALC 

16 Copy(Calc) Parameter‐Calc.CH‐Copy 

17 Group name Parameter‐Display‐Group name 

18 Group CH Parameter‐Display‐Group CH 

19 Graph display Parameter‐Display‐Graph display 

20 Auto display Parameter‐Display‐Auto display 

21 Setting(Main) Parameter‐Record‐Setting(Main) 

22 Setting(Sub) Parameter‐Record‐Setting(Sub) 

23 Schedule Parameter‐Record‐Schedule 

24 Unit Parameter‐Other‐Unit 

25 Message Parameter‐Other‐Message 

26 DI Parameter‐Other‐DI 

27 Progress time Parameter‐Other‐Progress time 

28 ProductsDisplay Parameter‐Other‐ProductsDisplay 

29 Int,SP DO Parameter‐Other‐Int,SP DO 

30 Param initial Parameter‐Other‐Param initial 

31 Wizard Parameter‐Other‐Wizard 

32 

System 

Param Save System‐SD/Param‐設定値保存 

33 Param load System‐SD/Param‐設定値読込 

34 Log output System‐SD/Param‐Log output 

35 Ethernet1 System‐Comm.‐Ethernet1 

36 Ethernet2 System‐Comm.‐Ethernet2 

37 SNTP1 System‐Comm.‐SNTP1 

38 SNTP2 System‐Comm.‐SNTP2 

39 FTP System‐Comm.‐FTP 

40 Remote AI System‐Comm.‐Remote AI 

41 Modbus1 System‐Comm.‐Modbus1 
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No. Major item Sub item Key,Operation 

42 

System 

Modbus2 System‐Comm.‐Modbus2 

43 ModbusMas System‐Comm.‐ModbusMas 

44 LCD System‐Device/Other‐LCD 

45 Clock System‐Device/Other‐Clock 

46 FUNC key System‐Device/Other‐FUNC key 

47 File format System‐Device/Other‐File format 

48 Jump menu System‐Device/Other‐Jump menu 

49 Mode System‐Device/Other‐Mode 

50 Language System‐Device/Other‐Language 

51 Version System‐Device/Other‐Version 

52 Key Lock System‐Security‐Key Lock 

53 Security Mode System‐Security‐Security Mode 

54 Trend Signature Signature operation with Ex.Sec Viewer (support software) 

55 
Hard buttun 

REC key The REC key of the hard button 

56 FUNC key The FUNC key of the hard button 
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Appendix 2 List of Security Logs 
 

No. Log When logs are generated 

1 Power ON When the power is turned on 
2 Power OFF When the power is turned off 
3 Record start When recording starts 
4 Record stop When recording ends 
5 Login When the user logs in 
6 Logout When the user logs out 
7 fail: Login When login fails 
8 Clear: Event log When the event history is cleared 
9 Clear: Ethernet log When the transmission history is cleared 
10 Add: Comment When a comment is added to the historical trend 
11 Edit: Comment When an existing comment is edited in the historical trend 
12 Delete: Comment When a comment is deleted from the historical trend 
13 Execute: mV Calibration When mV is calibrated (setting not released to users) 
14 Execute: Volt Calibration When V is calibrated (setting not released to users) 
15 Execute: RTD Calibration When RTD is calibrated (setting not released to users) 
16 Execute: RJC Calibration When RJC is calibrated (setting not released to users) 
17 Set: Input CH-Input When the OK key on the "Input" setting screen in the Input CH is touched  
18 Set: Input CH-Scaling When the OK key on the " Scaling " setting screen in the Input CH is touched 
19 Set: Input CH-Display When the OK key on the " Display " setting screen in the Input CH is touched 
20 Set: Input CH-Scale When the OK key on the " Scale " setting screen in the Input CH is touched 

21 Set: Input CH-Alarm value When the OK key on the " Alarm value " setting screen in the Input CH is 
touched 

22 Set: Input CH-Alarm action When the OK key on the " Alarm action " setting screen in the Input CH is 
touched 

23 Set: Input CH-REC/CALC When the OK key on the " REC/CALC " setting screen in the Input CH is 
touched 

24 Execute: Input CH-Copy When "Copy" in the Input CH is executed  
25 Set: Calc. CH-F value When the OK key on the " F value " setting screen in the Calc.CH is touched 
26 Set: Calc. CH-Timer When the OK key on the " Timer " setting screen in the Calc.CH is touched 
27 Set: Calc. CH-Display When the OK key on the " Display " setting screen in the Calc.CH is touched 
28 Set: Calc. CH-Scale When the OK key on the " Scale " setting screen in the Calc.CH is touched 

29 Set: Calc. CH-Alarm value When the OK key on the " Alarm value " setting screen in the Calc.CH is 
touched 

30 Set: Calc. CH-Alarm action When the OK key on the " Alarm action " setting screen in the Calc.CH is 
touched 

31 Set: Calc. CH-REC/CALC When the OK key on the " REC/CALC " setting screen in the Calc.CH is 
touched 

32 Execute: Calc. CH-Copy When "Copy" in the Calc.CH is executed  

33 Set: Display-Group name When the OK key on the " Group name " setting screen in the Display is 
touched 

34 Set: Display-Group CH When the OK key on the " Group CH " setting screen in the Display is touched 
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No. Log When logs are generated 

35 Set: Display-Graph display When the OK key on the " Graph display " setting screen in the Display is 
touched 

36 Set: Display-Auto display When the OK key on the " Auto display " setting screen in the Display is 
touched 

37 Set: Record-Setting(Main) When the OK key on the " Setting(Main) " setting screen in the Record is 
touched 

38 Set: Record-Setting(Sub) When the OK key on the " Setting(Sub)" setting screen in the Record is 
touched 

39 Set: Record-Schedule When the OK key on the " Schedule " setting screen in the Record is touched 
40 Add: Others-Unit When a new unit is added in the "Unit" setting in Others 
41 Edit: Others-Unit When an existing unit is edited in the " Unit” setting in Others 
42 Delete: Others-Unit When an existing unit is deleted in the " Unit " setting in Others 
43 Set: Others-Message When the OK key on the " Message " setting screen in the Others is touched 
44 Set: Others-DI When the OK key on the " DI " setting screen in the Others is touched 

45 Set: Others-ProductsDisplay When the OK key on the " ProductsDisplay " setting screen in the Others is 
touched 

46 Set: Others-Int.SP DO When the OK key on the " Int.SP DO " setting screen in the Others is touched 

47 Set: Others-Progress time When the OK key on the " Progress time " setting screen in the Others is 
touched 

48 Execute: Others-Progress Time-Manual 
reset When " Manual reset " in the Progress Time is executed  

49 Execute: Others-Param initial When " Param initial " in the Others is executed  
50 Execute: SD/Param-SD remove When " SD remove " in the SD/Param is executed  
51 Execute: SD/Param-SD format When " SD format " in the SD/Param is executed  
52 Execute: SD/Param-Param save When " Param save " in the SD/Param is executed  
53 Execute: SD/Param-Param load When " Param load " in the SD/Param is executed  
54 Execute: Log output When " Log output " is executed  
55 Set: Comm.-Ethernet1 When the OK key on the " Ethernet1 " setting screen in the Comm. is touched 
56 Set: Comm.-Ethernet2 When the OK key on the " Ethernet2 " setting screen in the Comm. is touched 
57 Set: Comm.-SNTP1 When the OK key on the " SNTP1 " setting screen in the Comm. is touched 
58 Execute: Comm.-SNTP1 Cal Start When " Cal Start " in the SNTP1is executed  
59 Set: Comm.-SNTP2 When the OK key on the " SNTP2 " setting screen in the Comm. is touched 
60 Add: Comm.-FTP user When a new FTP user is added in the "FTP" setting in Comm. 
61 Edit: Comm.-FTP user When an existing FTP user is edited in the "FTP" setting in Comm. 
62 Delete: Comm.-FTP user When an existing FTP user is deleted in the "FTP" setting in Comm. 
63 Set: Comm.-Remote AI When the OK key on the " Remote AI " setting screen in the Comm. is touched 
64 Set: Comm.-Modbus1 When the OK key on the " Modbus1" setting screen in the Comm.i s touched 
65 Set: Comm.-Modbus2 When the OK key on the " Modbus2" setting screen in the Comm. is touched 
66 Set: Device/Other-LCD When the OK key on the " LCD " setting screen in the Device/Other is touched 

67 Set: Device/Other-Clock When the OK key on the " Clock " setting screen in the Device/Other is 
touched 

68 Set: Device/Other-FUNK key When the OK key on the " FUNK key " setting screen in the Device/Other is 
touched 

69 Set: Device/Other-File format When the OK key on the " File format " setting screen in the Device/Other is 
touched 

70 Add: Device/Other-Jump menu When a new jump menu is added in the "Jump menu" setting in Device/Others 
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No. Log When logs are generated 

71 Delete: Device/Other-Jump menu When an existing jump menu is deleted in the "Jump menu" setting in 
Device/Others 

72 Set: Device/Other-Mode When the OK key on the " Mode " setting screen in the Device/Other is 
touched 

73 Set: Device/Other-Language When the OK key on the " Language " setting screen in the Device/Other is 
touched 

74 Set: Security-Security Mode When the OK key on the " Security Mode " setting screen in the Security is 
touched 

75 Set: Security-Key lock When the OK key on the " Key lock " setting screen in the Security is touched 
76 Add: Security-User Regist When a new user is added in the " user Regist." setting in Security 
77 Edit: Security-User Regist When an existing user is edited in the "user Regist." setting in Security 
78 Delete: Security-User Regist When an existing user is deleted in the " user Regist." setting in Security 
79 Execute: Remote AI Retry When the remote AI is reconnected 
80 Execute: ModbusMas Retry When the Modbus master is reconnected 
81 Execute: Addition reset When accumulation is reset with the FUNC button 

82 Auto Logout When no operations are performed for five minutes (only when "Auto + 
Manual" is set to the logout setting in the extended security mode) 

83 Execute: Register production 
information. Setting in production information setting by FUNC button When key is touched 

84 Set: ModbusMas.-Rd(Cyclic) When the OK key on the " Rd (Cyclic)" setting screen in the ModbusMas. is 
touched  

85 Set: ModbusMas.-Write Param When the OK key on the " Write Param" setting screen in the ModbusMas. is 
touched  

86 Set: ModbusMas.-Wrt (Cyclic) When the OK key on the " Wrt (Cyclic)" setting screen in the ModbusMas. is 
touched  

87 Set: ModbusMas.-Wrt (Display) When the OK key on the " Wrt (Display)" setting screen in the ModbusMas. is 
touched  

88 Set: ModbusMas.-Wrt (Event) When the OK key on the " Wrt (Event)" setting screen in the ModbusMas. is 
touched  

89 Execute: Button1 (Write Operation) When "Button 1" is touched on the write operation screen 

90 Execute: Button2 (Write Operation) When "Button 2" is touched on the write operation screen 

91 Execute: Button3 (Write Operation) When "Button 3" is touched on the write operation screen 

92 Execute: Button4 (Write Operation) When "Button 4" is touched on the write operation screen 

93 Execute: Button5 (Write Operation) When "Button 5" is touched on the write operation screen 

94 Execute: Button6 (Write Operation) When "Button 6" is touched on the write operation screen 

95 Execute: Button7 (Write Operation) When "Button 7" is touched on the write operation screen 

96 Execute: Button8 (Write Operation) When "Button 8" is touched on the write operation screen 
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Appendix 3  Record Format (ASCII) 
1.  Trend data file (***dmt.csv, ***dst.csv) 

 
(1) Header information 1 

The "Serial number," "Main version," "AI version," of the record data are output. 
(2) Header information 2 

This information is output only if [Add header information] is set to "Yes" at the time of 
conversion to CSV file format. 
The "Record cycle", "Record type", "Color," "Decimal point," "Meas. Range Lo and Hi," "Unit," 
"Tag," and "Description" of each channel registered with the record group are output.  
* For each setting, refer to the main unit instruction manual for the Paperless Recorder. 

(3) Header information 3 
This information is output only if [Add header information] is set to "Yes" at the time of 
conversion to CSV file format. 
The” Group name”, “Registration channel” of each display group tied with the record group are 
output. 
* For each setting, refer to the main unit instruction manual for the Paperless Recorder. 

(4) Measurement data 
Measurement data for each channel is output according to the record type setting. 
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2.  Event data file (***dme.csv) 

 

(1) Header information 1 
The "Serial number," "Main version," "AI version," of the record data are output. 

(2) Event data (alarm) 
The "Alarm type," "Alarm-source channel," "Alarm level," and "Status" of each alarm that 
occurred during recording are output. 
* For information on alarms, refer to Instruction Manual for the Paperless Recorder. 

(3) Event data (message) 
The "Message type" and "Message text" of each message generated during recording are output. 
* For information on alarms, refer to Instruction Manual for the Paperless Recorder. 

 

3.  Signature information file (***dms.csv,***dss.csv) 

    
(1) Header information 

The "Serial number," "Main version," "AI version," of the record data are output. 
(2) signature information 

"Signature state", "signer", "arbitrary character", "signature date and time" and "comment" are output as 
signature information. 
*signature information, refer to Section 5.3.4" Signature ". 
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Appendix 4  Extended security function list for 21 CFR Part 11 
 

Items 21 CFR Part11 Requirements Support status of extended security function 
§11.10. Controls for closed systems.  
§11.10. (a) 
 

Validation of systems to ensure accuracy, reliability, consistent 
intended performance, and the ability to discern invalid or altered 
records. 

×Unsupported 
It is necessary for the customer to construct the system. 

§11.10. (b) 
 

The ability to generate accurate and complete copies of records in 
both human readable and electronic form suitable for inspection, 
review, and copying by the agency. Persons should contact the 
agency if there are any questions regarding the ability of the agency 
to perform such review and copying of the electronic records. 

○Supported 
Recorded data is saved as custom binary data. 
By using the special PC software "Ex.Sec Viewer", you 
can browse recorded data, check the audit trail, print, and 
transfer data. 

§11.10. (c) 
 

Protection of records to enable their accurate and ready retrieval 
throughout the records retention period. 

×Unsupported 
It is necessary for the customer to manage the system. 
You should back up the data periodically by using export 
function. 

§11.10. (d)  Limiting system access to authorized individuals. ○Supported 
You can set up access restrictions by user name, 
password, level, and you can register up to 20 accounts. 
In addition, it is also possible to apply restrictions on 
operation items to the account whose level is "user". 

§11.10. (e) 
 

 Use of secure, computer-generated, time-stamped audit trails to 
independently record the date and time of operator entries and 
actions that create, modify, or delete electronic records. Record 
changes shall not obscure previously recorded information. Such 
audit trail documentation shall be retained for a period at least as 
long as that required for the subject electronic records and shall be 
available for agency review and copying. 

○Supported 
The operation log is always recorded by the audit trail 
function. 
It is output in binary format with recorded data. 
When data falsification etc. are detected, it becomes 
impossible to browse the data, so secure management is 
possible. 

§11.10. (f) 
 

Use of operational system checks to enforce permitted sequencing of 
steps and events, as appropriate. 

×Unsupported 
It is necessary for the customer to manage the system. 

§11.10. (g) Use of authority checks to ensure that only authorized individuals 
can use the system, electronically sign a record, access the operation 
or computer system input or output device, alter a record, or perform 
the operation at hand. 

○Supported 
You can set up access restrictions by user name, 
password, level, and you can register up to 20 accounts. 
In addition, it is also possible to apply restrictions on 
operation items to the account whose level is "user". 

§11.10. (h) Use of device (e.g., terminal) checks to determine, as appropriate, the 
validity of the source of data input or operational instruction. 

×Unsupported 
It is necessary for the customer to manage the system. 

§11.10. (i) Determination that persons who develop, maintain, or use electronic 
record/electronic signature systems have the education, training, and 
experience to perform their assigned tasks. 

×Unsupported 
It is necessary for the customer to manage the system. 

§11.10. (j) The establishment of, and adherence to, written policies that hold 
individuals accountable and responsible for actions initiated under 
their electronic signatures, in order to deter record and signature 
falsification. 

×Unsupported 
It is necessary for the customer to manage the system. 

§11.10. (k)  Use of appropriate controls over systems documentation including: 
(1) Adequate controls over the distribution of, access to, and use of 
documentation for system operation and maintenance. 
(2) Revision and change control procedures to maintain an audit trail 
that documents time-sequenced development and modification of 
systems documentation. 
 

×Unsupported 
It is necessary for the customer to manage the system. 
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Items 21 CFR Part11 Requirements Support status of extended security function 
§11.30. Controls for open systems.  
§11.30. Persons who use open systems to create, modify, maintain, or 

transmit electronic records shall employ procedures and controls 
designed to ensure the authenticity, integrity, and, as appropriate, the 
confidentiality of electronic records from the point of their creation to 
the point of their receipt. Such procedures and controls shall include 
those identified in §11.10, as appropriate, and additional measures 
such as document encryption and use of appropriate digital signature 
standards to ensure, as necessary under the circumstances, record 
authenticity, integrity, and confidentiality. 

×Unsupported 
It is necessary for the customer to manage the system. 
The extended security function is a closed system. 

§11.50. Signature manifestations.  
§11.50. (a) Signed electronic records shall contain information associated 

with the signing that clearly indicates all of the following: 
(1) The printed name of the signer; 
(2) The date and time when the signature was executed; and 
(3) The meaning (such as review, approval, responsibility, or 
authorship) associated with the signature. 
(b) The items identified in paragraphs (a)(1), (a)(2), and (a)(3) of this 
section shall be subject to the same controls as for electronic records 
and shall be included as part of any human readable form of the 
electronic record (such as electronic display or printout). 
 

○Supported 
Electronic signature is possible on the dedicated PC 
software "Ex.Sec Viewer". 
The electronic signature information is as follows. 
- Signature status (Pass / Fail) 
- Signer name 
- Signature time 
- Comment 
Up to three signatures are possible for one recorded data. 

§11.70. Signature/record linking.  
§11.70. Electronic signatures and handwritten signatures executed to 

electronic records shall be linked to their respective electronic 
records to ensure that the signatures cannot be excised, copied, or 
otherwise transferred to falsify an electronic record by ordinary 
means. 

○Supported 
Electronic signatures are automatically linked with 
recorded data when signed. Since it is linked, it can’t be 
deleted and copied. 

§11.100. General requirements.  
§11.100. (a) Each electronic signature shall be unique to one individual and shall 

not be reused by, or reassigned to, anyone else. 
○Supported 
Electronic signatures are possible only for registered 
accounts. When signing, login operation is required. It is 
also possible to prohibit the signature of the user level 
account. 

§11.100. (b)  Before an organization establishes, assigns, certifies, or otherwise 
sanctions an individual's electronic signature, or any element of such 
electronic signature, the organization shall verify the identity of the 
individual. 

×Unsupported 
It is necessary for the customer to manage the system. 

§11.100. (c) Persons using electronic signatures shall, prior to or at the time of 
such use, certify to the agency that the electronic signatures in their 
system, used on or after August 20, 1997, are intended to be the 
legally binding equivalent of traditional handwritten signatures. 

×Unsupported 
It is necessary for the customer to manage the system. 

§11.100. (1) The certification shall be submitted in paper form and signed with a 
traditional handwritten signature, to the Office of Regional 
Operations (HFC-100), 5600 Fishers Lane, Rockville, MD 20857. 

×Unsupported 
It is necessary for the customer to manage the system. 

§11.100. (2)  Persons using electronic signatures shall, upon agency request, 
provide additional certification or testimony that a specific electronic 
signature is the legally binding equivalent of the signer's handwritten 
signature. 

×Unsupported 
It is necessary for the customer to manage the system. 
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§11.200. Electronic signature components and controls.  
§11.200.(a) Electronic signatures that are not based upon biometrics shall: 

(1) Employ at least two distinct identification components such as an 
identification code and password. 
(i) When an individual executes a series of signings during a single, 
continuous period of controlled system access, the first signing shall 
be executed using all electronic signature components; subsequent 
signings shall be executed using at least one electronic signature 
component that is only executable by, and designed to be used only 
by, the individual. 
(ii) When an individual executes one or more signings not performed 
during a single, continuous period of controlled system access, each 
signing shall be executed using all of the electronic signature 
components. 
(2) Be used only by their genuine owners; and 
(3) Be administered and executed to ensure that attempted use of an 
individual's electronic signature by anyone other than its genuine 
owner requires collaboration of two or more individuals. 
 

（1）、（2）：○Supported 
This device restricts access by using a combination of two 
elements, a user name and a password. Also, duplication 
of combination of user name and password is prohibited. 
Every time you sign it you will be required to enter these 
two elements. 
 
（3）：×Unsupported 
It is necessary for the customer to manage the system. 

§11.200.(b) Electronic signatures based upon biometrics shall be designed to 
ensure that they cannot be used by anyone other than their genuine 
owners. 

×Unsupported 

§11.300. Controls for identification codes/passwords.  
§11.300. (a) Maintaining the uniqueness of each combined identification code and 

password, such that no two individuals have the same combination of 
identification code and password. 

○Supported 
Duplication of combination of user name and password is 
prohibited on this device. 

§11. 300.(b) Ensuring that identification code and password issuances are 
periodically checked, recalled, or revised (e.g., to cover such events 
as password aging). 

○Supported 
The expiration date of the password can be arbitrarily set 
from 1 to 365 days. If it expires, you will need to enter the 
previous password and enter the new password to be 
registered. 

§11. 300.(c) Following loss management procedures to electronically deauthorize 
lost, stolen, missing, or otherwise potentially compromised tokens, 
cards, and other devices that bear or generate identification code or 
password information, and to issue temporary or permanent 
replacements using suitable, rigorous controls. 

×Unsupported 
It is necessary for the customer to manage the system. 

§11. 300.(d) Use of transaction safeguards to prevent unauthorized use of 
passwords and/or identification codes, and to detect and report in an 
immediate and urgent manner any attempts at their unauthorized use 
to the system security unit, and, as appropriate, to organizational 
management. 

○Supported 
The following functions are provided to prevent 
unauthorized login. 
If the password mistake has been made ten consecutive 
times, the login operation of the target account is 
prohibited for 24 hours. 

§11. 300.(e) Initial and periodic testing of devices, such as tokens or cards, that 
bear or generate identification code or password information to ensure 
that they function properly and have not been altered in an 
unauthorized manner. 

×Unsupported 
It is necessary for the customer to manage the system. 
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